
Ordering the LotusScript Documentation Set
These books are available in the CD-ROM version of your SmartSuite package as Online Books, available for 
viewing on Lotus'    World Wide Web site (http://www.lotus.com/home.nsf/welcome/suitedev), and available in printed 
form in the SmartSuite Application Developer's Documentation Set. These books are available only in English.

• LotusScript Language Reference provides a comprehensive summary of conventions and basic commands for 
the LotusScript language. LotusScript Language Reference provides the foundation for programming any product 
that supports the LotusScript programming language.

• The LotusScript Programmer's Guide describes the basic building blocks for LotusScript applications and 
provides many working examples.

You can receive one complimentary copy of the SmartSuite LotusScript Documentation Set. To take advantage of this
offer, fill out the form below and mail it to the appropriate office, postmarked no later than December 31, 1998. The 
only additional charge you are responsible for is the shipping and handling fee. US customers can pay by check 
(payable to Lotus Development Corporation and drawn on a US bank) or credit card; others must pay by credit card. 
Please allow 4 - 6 weeks for delivery.
For details on mailing addresses and shipping and handling charges, see the online Fulfillment Information.
Name ________________________________________________________________

Company ________________________________________________________________

Address 1 (no PO boxes please) _______________________________________________

Address 2    _________________________________________________________________

City __________________________    State/Province _______________________________

Zip/Postal Code ____________      Phone ( ____ ) _____ - _________ ext. ______

Shipping and handling charge: ___________

Payment Method:        Visa / Mastercard / Amex / Check    (circle one)

Card Number ________________________    Exp Date ________ / _____

Signature ___________________________________________________



Overview: Fulfillment Information
Refer to the following table when ordering the Application Developer's Documentation Set for SmartSuite.

• Identify the fulfillment center/centre for your country
• Copy the mailing address to the front of an envelope coupon
• Insert payment for shipping and handling charges and the order form into the envelope

Use the appropriate shipping and handling charge for your country
Note The following charges include VAT (Value Added Tax) where applicable.

Country Currency Charge Fulfillment Center 
Mailing address

Australia Australian Dollar A$35 Lotus Development Pty Ltd
Customer Service Department
Level 12, 321 Kent Street
Sydney NSW 2000
Australia

Austria Austrian Schilling 300 OS

Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Belgium Belgian Franc 900BF Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Canada Canadian Dollar C$15 Lotus Development Corporation
SmartSuite Documentation
P.O. Box 670
Scarborough, Ontario      M1K 
5C5

Denmark Danish Krone Dkr 175 Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Finland Markka
130 mk Product Fulfillment Programme

Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

France French Franc 150F Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Germany
Deutchmark 45 DM Product Fulfillment Programme

Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Ireland IR£15 Product Fulfillment Programme



Punt Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Italy Lira
L. 4500

Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Netherlands
Guilder F 50 Product Fulfillment Programme

Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

New Zealand New Zealand 
Dollar

NZ$40 Lotus Development New 
Zealand Ltd
Customer Service Dept
Level 20, ASB Bank Centre
Cnr Albert & Wellesley Sts
Auckland New Zealand

Norway Norwegian Krone Nkr 190 Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Portugal Escudo 4500 Esc. Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

South Africa South African 
Rand

R135 Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Spain
Peseta

3500Pts Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Sweden Krona
200 Skr Product Fulfillment Programme

Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland

Switzerland
Swiss Franc SFr 35

Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland



United States US Dollar $10 Lotus Development Corporation
SmartSuite Documentation
P.O. Box 25367
Rochester NY 14625-0367      
USA

United Kingdom
Sterling £15

Product Fulfillment Programme
Lotus Development, Unit 12
Airways Industrial Estate
Cloghran
Dublin 17
Ireland



LotusScript Documentation on the World Wide Web
You can view updated versions of LotusScript documentation, or download updated sample applications or Help files 
from the SmartSuite Developers home page.
Enter the following URL in the location field in your browser and press ENTER:
www.lotus.com/home.nsf/welcome/suitedev



LotusScript User Assistance for SmartSuite
To help you learn how to develop LotusScript applications for SmartSuite, Lotus provides a complete library of user 
assistance. 
The following books are available in hardcopy, Adobe Acrobat, or HTML formats in your SmartSuite package,    in the 
SmartSuite Application Developer's Documentation Set, or on the World Wide Web.

Getting the Most Out of LotusScript in SmartSuite Release 9
This publication explains how SmartSuite products use the LotusScript programming language and how your 
business can take advantage of LotusScript in developing applications for SmartSuite.

LotusScript Language Reference
This publication provides a comprehensive summary of conventions and basic commands for the LotusScript 
language. LotusScript Language Reference provides the foundation for programming any product that supports the 
LotusScript programming language.

LotusScript Programmer's Guide
This publication is a general introduction to LotusScript that describes basic building blocks in the language and 
explains how to use them to create powerful applications.

Class Reference Help and Frequently asked Questions
Each product provides comprehensive Help on product classes, frequently asked questions about programming, and 
code examples. All this is delivered in an innovative Help system designed to enhance your work as a programmer.
Class reference Help and frequently asked questions are available in Help format in your SmartSuite package and in 
HTML format on the World Wide Web.

Example code and sample applications
Most products also provide working code to illustrate important programming techniques. You can reuse and modify 
this code as you develop your own applications.
Example code is available in the SmartSuite package and on the World Wide Web.



Accessing Lotus on the Web
You can access Lotus and IBM home pages on the World Wide Web.
1. Click the Suite Help drawer to open it.
2. Click the Lotus Online folder.
3. Click one of the links.
Note You must have a Internet access to navigate to these home pages.

{button ,AL(`H_SC_SUITE_INFO_DRAWER_OVER',0)} See related topics



Adding applications to SuiteStart
You can add application icons to SuiteStart.
1. Right-click a SuiteStart icon.

2. Choose Add File.
3. Select the application icon to add.
4. Click Open.

{button ,AL(`H_SC_REMOVING_APPLICATIONS_FROM_SMARTSTART_STEPS;H_SC_SMARTSTART_OVER;H_
SC_REMOVING_SMARTSTART_STEPS',0)} See related topics



Adding drawers
You can add new drawers to SmartCenter.
1. Click the SmartCenter Menu button.

2. Choose New Drawer.
3. Click in the right side of the Drawer label box and press Backspace until you have deleted the existing label.
4. Type a label for the drawer in the Drawer label box.
5. Select a drawer handle.
6. Click OK.
Note You can have up to 50 drawers total in SmartCenter.

{button ,AL(`H_SC_MOVING_DRAWERS_STEPS;H_SC_DELETING_DRAWERS_STEPS;H_SC_DRAWERS_OVE
R;H_SC_CHANGING_DRAWER_LABELS_STEPS;H_SC_CHANGING_THE_HANDLE_COLORS_OF_DRAWER
S_STEPS;H_SC_DRAG_AND_DROP_OVER',0)} See related topics



Adding files to file folders
You can add files, shortcuts, applications, and other folders to file folders in SmartCenter.
1. Click the drawer to open it.
2. Click the folder where you want to add the file.
3. Drag the file from the Windows desktop or from Windows Explorer and drop it into the opened folder.

Tip If you use the right mouse button to drag a file to a drawer, a menu appears with the available options.
4. Click the front of the drawer to close it.
Tip See Overview: Dragging and Dropping in SmartCenter for more information.

{button ,AL(`H_SC_ADDING_NOTES_DATABASE_STEPS;H_SC_DELETING_FILES_STEPS;H_SC_FILE_FOLDE
RS_OVER;H_SC_DRAG_AND_DROP_OVER',0)} See related topics



Adding new folders to drawers
1. Click the drawer to open it.
2. Click the drawer menu button.

3. Choose New Folder. The New Folder assistant appears.
4. Select the type of folder you want to create in Step 1 of the New Folder assistant and then click Next.

Note When you finish a step in the assistant, click Next to proceed to the next step.
5. When you complete the last step in the New Folder assistant, click Done.
6. Click the front of the drawer to close it.
Tip You can drag and drop a new folder with an object in it to a drawer.

{button ,AL(`H_SC_FOLDERS_OVER;H_SC_DRAG_AND_DROP_OVER;H_SC_MOVING_FOLDERS_BETWEEN_
DRAWERS_STEPS',0)} See related topics



Adding Notes databases to file folders
You can add Notes database shortcuts to the Notes Databases folder in the SmartSuite drawer or to other file folders 
you have created in SmartCenter.
1. Click the drawer to open it.
2. Click the file folder where you want to add the Notes database shortcut.
3. Click the folder icon.
4. Choose Add Notes Database.
5. Select the database that you want to add.

Note    Enter your password if you have created one in Notes.
6. Click OK. 
7. Click the front of the drawer to close it. 

{button ,AL(`H_SC_DELETING_FILES_STEPS;H_SC_ADDING_FILES_TO_DRAWERS_STEPS;H_SC_FILE_FOLD
ERS_OVER',0)} See related topics



Adding and editing reminders
1. Click the Reminders drawer to open it.
2. Click either the Home or Business folder.
3. Click in the blank box in the folder and begin entering your reminder.

Note Press CTRL-Enter to start a new line, and press CTRL-Tab to insert a tab in your description.
4. Press Enter to complete the message.
Tip You can drag reminders from one reminder folder to another, or you can drag them to the desktop.

Editing reminders
To edit a reminder, simply double-click the reminder and enter your changes.

{button ,AL(`H_SC_KEEPING_REMINDERS_ON_TOP_STEPS;H_SC_OVERVIEW_REMINDER_FOLDER_OVER;
H_SC_ADDING_DRAWERS_STEPS;H_SC_CHECKING_OFF_REMINDERS_STEPS;H_SC_DELETING_REMIN
DERS_STEPS',0)} See related topics



Assigning sounds to drawer events
You can assign different sounds for different events, like opening, closing, removing, and adding drawers. 
1. Click the SmartCenter Menu button.

.
2. Choose SmartCenter Properties.
3. Click the Effects tab.
4. Select the event that you want to assign a sound in the Event box.
5. Select the sound that you want to hear for that event in the Sound box.

Tip Click  to preview a sound, and click 

 to stop the preview from playing.
6. Click OK.
Note If you want to use the sound features of SmartCenter, you must have the hardware and software for sounds 
installed.

{button ,AL(`H_SC_CHANGING_DRAWER_SPEED_STEPS;H_SC_DEFINING_A_TEXTURE_FOR_DRAWERS_ST
EPS;H_SC_SMARTCENTER_PROPERTIES_OVER;H_SC_TURNING_OFF_SOUNDS_STEPS',0)} See related 
topics



Overview: Calendar folders
Calendar folders let you keep track of your appointments.    Appointments appear in the folder as white cards 
spanning the time covered by an appointment in fifteen minute increments. You can add brief descriptions to your 
appointments, as well as move or delete appointments.

You can scroll through the day's appointments by clicking the AM  or PM 

 icons.

Use the Date icon  to change the display date. Click the lower left corner to go to a previous day. Click 
the lower right corner to advance a day.

Click the "Days to display" icon  to change the number of days that appear. If you want to display seven 
days, click the Maximize button 

 located in the top right corner of the drawer.

The current time
A red dot displays in the calendar next to the current time.

Using the Calendar and Organizer together
The information in your calendar folder is stored in a source file. There are two kinds of source files: text (.TXT 
extension) and Organizer (OR2, .OR3, or .OR4 extension). Organizer files are used for storing information in Lotus 
Organizer (the PIM-only version without group scheduling capabilities).
During installation, SmartCenter detects if you are already using Organizer. If your Organizer preferences are set to 
automatically open an .OR2, .OR3, or .OR4 file, then the Organizer file becomes your source file for the calendar 
folder. Every time you open the calendar folder, it refreshes with new information from Organizer.
If you are not using Organizer, or the calendar section of Organizer, SmartCenter install creates a .TXT file named 
CALENDAR.TXT for your source file. Later on, if you start to use Organizer, you can change your calendar source file
in SmartCenter.

Converting Organizer files
You can convert your files from previous releases of Organizer to .OR4 files.    While working in Organizer:
1. Choose Help - Help Topics and click the Index tab.
2. Type this phrase:

Converting files, from previous releases
3. Click the index entry you want, then click Display.

Calendar security
The first time you open a calendar folder after you start SmartCenter, it prompts you for your Organizer password if 
you have one. You will not be prompted for your password again, unless you choose Clear Passwords. If you clear 
your passwords, you must reenter your passwords the next time you want to use your calendar folder or any other 
password-protected folder.
You clear passwords by clicking the folder icon in an open folder and choosing Clear Passwords.

{button ,AL(`H_SC_CHANGING_APPOINTMENT_DESCRIPTIONS_STEPS;H_SC_CHANGING_APPOINTMENTS_
STEPS;H_SC_CHANGING_CALENDAR_SOURCE_STEPS;H_SC_CHANGING_THE_NUMBER_OF_DAYS_ST
EPS;H_SC_DELETING_FOLDERS_STEPS;H_SC_MOVING_APPOINTMENTS_STEPS;H_SC_SCHEDULING_
APPOINTMENTS_STEPS;H_SC_STARTING_ORGANIZER_FROM_CALENDAR_STEPS',0)} See related topics



Changing the duration of appointments
You can change both the beginning and ending times of appointments.

Changing the ending time of appointments
1. Click the Calendar drawer to open it.
2. Position the mouse pointer over the current ending point of the appointment. The pointer changes to a two-

headed arrow.
3. Drag the mouse pointer to the new ending point of the appointment.    Appointments snap to the nearest quarter 

hour increment.
4. Click the front of the drawer to close it.

Changing the beginning time of appointments
1. Click the Calendar drawer to open it.
2. Position the mouse pointer inside the appointment. The pointer changes to a hand.
3. Drag    the appointment to the new beginning time.
4. Click the front of the drawer to close it.

{button ,AL(`H_SC_CALENDAR_FOLDER_OVER;H_SC_CHANGING_APPOINTMENT_DESCRIPTIONS_STEPS;H
_SC_DELETING_AN_APPOINTMENT_STEPS',0)} See related topics



Changing appointment descriptions
1. Click the Calendar drawer to open it.
2. Position the mouse pointer inside the appointment box. The pointer changes to a hand.
3. Double-click to display the Appointment Properties dialog box.
4. In the Description box, select the text that you want to change, and begin typing.

Note Press CTRL-Enter to start a new line, and press CTRL-Tab to insert a tab in your description.
5. When you finish, click OK.
6. Click the front of the drawer to close it.

{button ,AL(`H_SC_CALENDAR_FOLDER_OVER;H_SC_CHANGING_APPOINTMENTS_STEPS;H_SC_CHANGIN
G_THE_NUMBER_OF_DAYS_STEPS',0)} See related topics



Changing calendar folder source files
You can change the source file that calendar folders use.
1. Click the Calendar drawer to open it.
2. Right-click the folder label.
3. Choose Folder Properties.
4. Select the Calendar tab.
5. Select the type of source file in the File type box.
6. Type the path and file name of the new Organizer file or text file that you want to use in the calendar folder in the 

"Name of Organizer/tex file" box.
7. (Optional) If you select Lotus Organizer as your file type, you can also select the calendar section that you want to

use.
8. Click OK.
Tip Click Browse to locate the Organizer file or text file that you want to use. Depending on the version of Organizer 
you use, the Organizer files must have an extension of .OR2, .OR3, or .OR4.

{button ,AL(`H_SC_CALENDAR_FOLDER_OVER',0)} See related topics



Changing drawer labels
You can change the label that appears on the front of a drawer.
1. Right-click the drawer.
2. Choose Drawer Properties.
3. Click in the right side of the Drawer label box, and press Backspace until the existing label has been deleted.
4. Type the new label.
5. Click OK.

{button ,AL(`H_SC_CHANGING_THE_HANDLE_COLORS_OF_DRAWERS_STEPS;;H_SC_DRAWERS_OVER;H_S
C_SMARTCENTER_PROPERTIES_OVER',0)} See related topics



Changing the opening    and closing speed for drawers
You can change the speed at which drawers open and close.    The drawer-speed slider controls the opening and 
closing speed for all the drawers in SmartCenter.
1. Click the SmartCenter Menu button.

2. Choose SmartCenter Properties.
3. Click the Effects tab.
4. Drag the drawer-speed slider left to decrease drawer speed or right to increase drawer speed.
5. Click OK.

{button ,AL(`H_SC_ASSIGNING_SOUNDS_STEPS;H_SC_OVERVIEW_DRAWERS_OVER;H_SC_RESIZING_DRA
WERS_STEPS;H_SC_SMARTCENTER_PROPERTIES_OVER',0)} See related topics



Changing drawer handles
You can change the handle that appears on the front of a drawer.
1. Right-click the drawer.
2. Choose Drawer Properties.
3. Select a handle from the Drawer handle box.
4. Click OK. 

{button ,AL(`;H_SC_CHANGING_DRAWER_LABELS_STEPS;H_SC_DRAWERS_OVER;H_SC_SMARTCENTER_P
ROPERTIES_OVER',0)} See related topics



Changing the number of days that appear in calendar folders
Calendar folders can display up to seven days.
1. Click the Calendar drawer to open it.
2. Click the rectangle in the Days to display icon that corresponds to the number of days that you want to appear.

For example, to display four days, click in the fourth rectangle of the icon.

3. Click the front of the drawer to close it.

Tip To display seven days in your calendar, click the Maximize button  in the top right corner of the drawer. 

{button ,AL(`;H_SC_CALENDAR_FOLDER_OVER;H_SC_CHANGING_APPOINTMENT_DESCRIPTIONS_STEPS;
H_SC_CHANGING_APPOINTMENTS_STEPS;H_SC_MOVING_APPOINTMENTS_STEPS;H_SC_SCHEDULIN
G_APPOINTMENTS_STEPS;',0)} See related topics



Deleting appointments
1. Click the Calendar drawer to open it.
2. Right-click the appointment that you want to delete.
3. Choose Delete Appointment.
4. Click Yes in the Delete Appointment dialog box.
5. Click the front of the drawer to close it.
Note If Organizer is the source of your calendar, the appointment is deleted from your Organizer calendar, too.

{button ,AL(`H_SC_CALENDAR_FOLDER_OVER;;H_SC_CHANGING_APPOINTMENT_DESCRIPTIONS_STEPS;
H_SC_CHANGING_APPOINTMENTS_STEPS;H_SC_MOVING_APPOINTMENTS_STEPS;H_SC_SCHEDULIN
G_APPOINTMENTS_STEPS;',0)} See related topics



Deleting drawers
When you delete a drawer, you delete the folders that it contains, too.
1. Right-click the drawer that you want to delete.
2. Choose Delete Drawer.
3. Click Yes to remove the drawer from SmartCenter.
Note If the deleted drawer contained shortcuts to a folder or file, the original item is still preserved on disk.

{button ,AL(`H_SC_ADDING_DRAWERS_STEPS;H_SC_MOVING_DRAWERS_STEPS;H_SC_RESIZING_DRAWE
RS_STEPS;H_SC_DRAWERS_OVER',0)} See related topics



Deleting files from file folders
You can delete files and shortcuts from file folders in SmartCenter.
1. Click the drawer to open it.
2. Click the file folder containing the file that you want to delete.
3. Select the icon for the file that you want to delete.
4. Press Delete.
5. Click Yes to move the file to the Recycle Bin.
6. Click the front of the drawer to close it.
Note If you are deleting a shortcut to a file, the original file remains on the disk.

{button ,AL(`H_SC_ADDING_FILES_TO_DRAWERS_STEPS;H_SC_FILE_FOLDERS_OVER',0)} See related topics



Removing pop-up labels on drawers
You can remove the pop-up help that displays when you position the mouse over a drawer.
1. Click the SmartCenter Menu button.

2. Choose SmartCenter Properties.
3. Deselect the "Display popup help" box.
4. Click OK.

{button ,AL(`H_SC_CHANGING_DRAWER_LABELS_STEPS;H_SC_OVERVIEW_DRAWERS_OVER;H_SC_CHAN
GING_THE_HANDLE_COLORS_OF_DRAWERS_STEPS',0)} See related topics



Moving SmartCenter
You can anchor SmartCenter to either the top or bottom of the screen.
1. Click the SmartCenter Menu button.

 
2. Choose SmartCenter Properties.
3. Select the location on the screen that you want.
4. Click OK.
Tip You can also double-click the blank, right end of SmartCenter to move it between the top and bottom part of the 
screen.

{button ,AL(`H_SC_MOVING_DRAWERS_STEPS;H_SC_OVERVIEW_DRAWERS_OVER;H_SC_REMOVING_SMA
RTCENTER_STEPS',0)} See related topics



Overview: Using Help
All the information you need to use SmartCenter™ and SuiteStart and to perform cross-application tasks can be 
found in SmartSuite® Help. 
You can request Help in the following ways:

• Click the SmartCenter Menu button  and choose Help Topics.
• Click the Suite Help drawer, then double-click the SmartSuite Help icon in the Help folder. 

• Click the Contents tab, and browse through the Help books to find topics of interest. You can print an entire 
book of Help topics by highlighting the book and clicking Print or you can print a single topic. 

• Click the Index tab to use keywords for searching. Type a word to locate an index entry, or scroll through the 
list.

• Click the Find tab to do a full-text search. 
• When reading a Help topic, you can: 

• Click green text with a solid underline to jump to another Help topic.
• Click green text with a dotted underline to read a definition.
• Print the topic by clicking Print. 
• Click Related Topics at the bottom of the topic to see a list of related Help topics.
• Click Go Back to return to the previously displayed Help topic. 

• Click the Help button in a dialog box for information about that dialog box. 

{button ,AL(`;H_SC_SUITE_INFO_DRAWER_OVER',0)} See related topics



Moving appointments to other times
You can change appointment times in calendar folders. You can move an appointment up to six days away from the 
current day.
1. Click the Calendar drawer to open it.
2. Position the mouse pointer inside the appointment that you want to move. The pointer changes to a hand.
3. Drag the appointment to the new time or day. Appointments snap to the nearest quarter hour increment.

Tip To change the number of days that appear, click the rectangle in the Days to display icon  that 
corresponds to the number of days you want to appear. 

4. Click the front of the drawer to close it.

{button ,AL(`H_SC_CALENDAR_FOLDER_OVER;H_SC_CHANGING_APPOINTMENT_DESCRIPTIONS_STEPS;H
_SC_CHANGING_APPOINTMENTS_STEPS;H_SC_DELETING_AN_APPOINTMENT_STEPS;H_SC_SCHEDUL
ING_APPOINTMENTS_STEPS',0)} See related topics



Moving drawers
1. Position the mouse pointer over the closed drawer that you want to move.
2. Drag the drawer to its new position.
Tip If you want a drawer to appear as the first drawer on the left, drag it to the SmartCenter Menu button.

{button ,AL(`H_SC_ADDING_DRAWERS_STEPS;H_SC_DELETING_DRAWERS_STEPS;H_SC_DRAWERS_PLAC
E_ON_SCREEN_STEPS;H_SC_DRAWERS_OVER',0)} See related topics



Opening and closing drawers
Click the front of a drawer to open or close it.

{button ,AL(`H_SC_ASSIGNING_SOUNDS_STEPS;H_SC_CHANGING_DRAWER_SPEED_STEPS;;H_SC_DRAW
ERS_OVER',0)} See related topics



Overview: SmartCenter
SmartCenter™ works like a cabinet of drawers and folders that help you to organize and manage your work. 

From SmartCenter you can:
• Start all your applications
• Consult your address book and calendar
• Create reminder lists
• Find definitions in the dictionary and synonyms in the thesaurus
• Retrieve information from the Web without leaving SmartCenter

• Get news updates, stock quotes, and weather forecasts
• Make travel reservations
• Read tips on using SmartSuite
• Get driving directions and maps
• Visit your bookmarked or favorite sites

• Add new folders with links to the Web, views of Notes databases, and more

SmartCenter drawers
SmartCenter drawers work like drawers in your desk. When you first start SmartCenter you get a set of drawers 
designed to let you organize your different kinds of work. These drawers are

• SmartSuite
• Internet (optional)
• Calendar
• Addresses
• Reminders
• Reference
• Suite Help
• Business Productivity

SmartCenter folders
Drawers can contain a variety of types of folders. Some SmartCenter folders work like folders on your desktop, some 
are designed like calendars or address books, and some folders come with tools that let you look up word definitions, 
surf the Internet, and much more.

SmartCenter is customizable
You can anchor SmartCenter to either the top or bottom of your screen. You can add or remove drawers and folders, 
rearrange their order, and change their titles and appearance.

{button ,AL(`;H_SC_ASSIGNING_SOUNDS_STEPS;H_SC_CHANGING_DRAWER_SPEED_STEPS;H_SC_DEFINI
NG_A_TEXTURE_FOR_DRAWERS_STEPS;H_SC_DRAWERS_PLACE_ON_SCREEN_STEPS;H_SC_REMOVI



NG_SMARTCENTER_STEPS;H_SC_RESERVING_MINIMUM_SPACE_FOR_SMARTCENTER_STEPS;H_SC_R
ESIZING_DRAWERS_STEPS;H_SC_TURNING_OFF_SOUNDS_STEPS;H_SC_SMARTCENTER_PROPERTIE
S_OVER;H_SC_DRAG_AND_DROP_OVER;H_SC_DRAWERS_OVER;H_SC_FOLDERS_OVER',0)} See related
topics



Removing applications from SuiteStart
You can remove application icons from SuiteStart. When you remove an application icon from SuiteStart, 
SmartCenter automatically removes the application icon from the Lotus Applications folder.
1. Right-click the application icon in SuiteStart that you want to remove.
2. Choose Remove "application name" Icon.
Note This procedure removes application icons from SuiteStart. It does not delete the actual application.

{button ,AL(`H_SC_ADDING_APPLICATIONS_TO_SMARTSTART_STEPS;H_SC_SMARTSTART_OVER;H_SC_RE
MOVING_SMARTSTART_STEPS',0)} See related topics



Removing SmartCenter
You can remove SmartCenter from your screen.
1. Click the SmartCenter Menu button.

2. Choose Exit SmartCenter.
Note To bring SmartCenter back again, choose Start - Programs - Lotus SmartSuite - Lotus SmartCenter.

{button ,AL(`H_SC_OVERVIEW_DRAWERS_OVER;H_SC_DRAWERS_PLACE_ON_SCREEN_STEPS',0)} See 
related topics



Removing SuiteStart
You can remove SuiteStart from the taskbar.
1. Right-click SuiteStart.
2. Choose Exit.
Note To bring SuiteStart back again, choose Start - Programs - Lotus SmartSuite - Lotus SuiteStart.

{button ,AL(`H_SC_ADDING_APPLICATIONS_TO_SMARTSTART_STEPS;H_SC_REMOVING_APPLICATIONS_F
ROM_SMARTSTART_STEPS;H_SC_SMARTSTART_OVER',0)} See related topics



Resizing drawers
You can change the width or length of a drawer.
1. Click the drawer to open it.
2. Position the mouse pointer along the front or the right side of the opened drawer. The pointer changes to a 

double-headed arrow.
3. Drag the drawer until it reaches the length or width that you want.
4. Click the front of the drawer to close it.

{button ,AL(`H_SC_ADDING_DRAWERS_STEPS;H_SC_DELETING_DRAWERS_STEPS;H_SC_MOVING_DRAWE
RS_STEPS;H_SC_DRAWERS_OVER',0)} See related topics



Scheduling appointments
1. Click the Calendar drawer to open it.
2. Select a date:

• Click the center of the Date icon to display the calendar for the current month.

• Use the left and right arrows in the monthly calendar if you want to change the month.
• Click the lower left corner of the Date icon to display a previous day; click the lower right corner to advance a 

day.

3. Position the mouse pointer at the beginning time for your appointment.
4. Drag the mouse pointer down to the ending time of your appointment. 
5. When the Create Appointment dialog box appears, type a description of your appointment in the Description box.

Note Press CTRL-Enter to start a new line, and press CTRL-Tab to insert a tab in your description.
6. Click OK.
7. Click the front of the drawer to close it.
Notes

• The appointment starting and ending times snap to the nearest 15 minute (quarter hour) increment. If 
appointments overlap, a red indicator appears on the right side of the appointment box.

• If Organizer is your source file, the appointment appears in your Organizer calendar, too.

{button ,AL(`H_SC_CALENDAR_FOLDER_OVER;H_SC_CHANGING_APPOINTMENT_DESCRIPTIONS_STEPS;H
_SC_CHANGING_APPOINTMENTS_STEPS;H_SC_DELETING_AN_APPOINTMENT_STEPS;H_SC_MOVING_
APPOINTMENTS_STEPS',0)} See related topics



Overview: SuiteStart
SuiteStart is an icon palette that lets you easily start Lotus applications by clicking the icon. SuiteStart appears 
opposite the Start button on your taskbar.

 
The first time that you start SuiteStart, it automatically adds icons for all the Lotus applications that you have installed 
on your system. You can also add icons for non-Lotus applications and files, so you can start them easily as well. 

{button ,AL(`H_SC_ADDING_APPLICATIONS_TO_SMARTSTART_STEPS;H_SC_REMOVING_APPLICATIONS_F
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Overview: SmartSuite drawer
The SmartSuite drawer lets you organize and easily start Lotus applications, work files, and SmartMaster™ 
templates. The folders in the SmartSuite drawer are file folders. The SmartSuite drawer may contain the following 
folders:

Lotus Applications folder
The Lotus Applications folder contains shortcuts to all of your Lotus applications. When you start SmartCenter, it adds
shortcut icons for all the Lotus applications that you have installed. You can easily add shortcut icons for non-Lotus 
applications that you want to quickly start, too.

SmartMaster Templates folder
The SmartMaster Templates folder contains sample SmartMaster templates from individual SmartSuite applications. 

Notes Databases folder
If you have Notes™ software, the Notes Databases folder contains a shortcut to your Notes mail database.    You can 
easily add icons for other Notes databases.

Work folders
SmartCenter adds a folder for each Lotus application that you install. Each folder is a shortcut    to the work folder of 
an individual Lotus application. For example, the Word Pro Documents folder is a shortcut to the work folder of Word 
Pro. You can also add folders for non-Lotus applications. 

{button ,AL(`H_SC_CHANGING_DRAWER_LABELS_STEPS;H_SC_DELETING_FOLDERS_STEPS;H_SC_MOVIN
G_DRAWERS_STEPS;H_SC_DRAG_AND_DROP_OVER;H_SC_MOVING_FOLDERS_BETWEEN_DRAWERS_
STEPS',0)} See related topics



Step 3: Display
Use Step 3 to specify appearance properties for your folder.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

Display files as
Select the size of the icons that appear in the folder.

Arrange by
Icons represent files. The icons can be arranged by file name, type, size,    or date.



Overview: Suite Help drawer
The Suite Help drawer includes the following different types of user assistance:

SmartSuite Help
You are currently using SmartSuite Help. It offers information on using SmartCenter to help you organize and quickly 
access your work. SmartSuite Help also provides information on how to use SmartSuite cross-application features. 
For example, you can learn how to use an Approach® database for a mass mailing in Word Pro®.
To open SmartSuite Help, click the SmartSuite Help icon in the Help folder. You can also open SmartSuite Help while 
you are using a dialog box by clicking the Help button.

DocOnline
DocOnline provides online versions of user manuals for all the SmartSuite applications, and makes it available 
through Adobe Acrobat Reader. To view a DocOnline book, double-click the appropriate icon in the DocOnline folder. 
Note DocOnline is available only if you installed SmartSuite from CD-ROM.

Lotus Online
The Lotus® Online folder links to Lotus and IBM® pages on the Web. Consult this site for the latest information on 
new products and upgrades.

SmartSuite Tips
The SmartSuite Tips folder contains valuable tips on using SmartSuite. Tips are updated daily by the computer 
experts at TipWorld -- a member of the PC World Online Network. The SmartSuite Tips folder helps you to make the 
most of SmartSuite.

{button ,AL(`H_SC_GETTING_HELP_OVER;',0)} See related topics



Adding Web sites to SmartCenter
You can add Internet folders to SmartCenter that link to your favorite Web (World Wide Web) sites.
1. Click the drawer where you want to add an Internet folder.
2. Click the drawer menu button.

3. Choose New Folder.
The New Folder assistant opens to Step 1.

4. Select Internet Page as the folder type, and click Next.
5. Select a folder label, color, and icon, and then click Next.
6. Enter the URL path of the Web site in the Internet Location box.
7. (Optional) Click Internet Settings to change your port or proxy server.
8. (Optional) Click the Reload box to select a time if you want to periodically update the folder.
9. Click Done.

{button ,AL(`;H_SC_OVERVIEW_INTERNET_FOLDERS_OVER',0)} See related topics



Adding stocks to stock folders
1. Click the Internet drawer to open it.
2. Click the Stock Quotes folder to open it.
3. Click the folder icon.
4. Choose Folder Properties.
5. Click Stocks.
6. Click Add.
7. Type the stock symbol, and click OK.

Note If you do not know the stock symbol, click Symbol Guide to find the symbol for the stock that you want to 
track.

8. (Optional) Click Internet Settings to change your port or proxy server.
9. Click OK.

{button ,AL(`H_SC_OVERVIEW_INTERNET_FOLDERS_OVER;H_SC_DELETING_STOCKS_STEPS',0)} See 
related topics



Changing locations in weather folders
1. Click the Internet drawer to open it.
2. Click the Weather folder.
3. Right-click the folder label.
4. Choose Folder Properties.
5. Click Weather.
6. Select the new region where you want to check the weather.
7. Select the new city.
8. Click OK.

{button ,AL(`;H_SC_OVERVIEW_INTERNET_FOLDERS_OVER',0)} See related topics



Configuring Internet settings
For guidance using proxies, see your system administrator.
1. Open an Internet, Web Reference, Travel Reservations, or Lotus Online folder.
2. Right-click the folder label.
3. Choose Folder Properties.
4. Click either the News, Weather, Stocks, Options, or URL tab.

Note Only one of these tabs displays, depending on the type of folder you have opened.
5. Click Internet Settings.
6. Enter a server name and a port number.

Note If Internet Explorer is installed on your system, you cannot change the server name and port number in 
SmartCenter. You must change these settings in Internet Explorer. The next time you start SmartCenter, the 
settings will be automatically updated.

7. (Option) Click the "Access the Internet via an HTTP proxy server" box if it is appropriate.
8. Click OK to close the Internet Settings dialog box.
9. Click OK to close the Folder Properties dialog box.
10. Click the front of the drawer to close it.
Note The Internet Settings dialog box controls the Internet configuration for all of your Internet, Web Reference, 
Travel Reservations, and Lotus Online folders. You don't need to configure your settings for each Internet folder.

{button ,AL(`;H_SC_ADDING_INTERNET_FOLDERS_STEPS;H_SC_OVERVIEW_INTERNET_FOLDERS_OVER',0
)} See related topics



Removing stocks from the stock folders
1. Click the Internet drawer to open it.
2. Click the Stock Quotes folder to open it.
3. Right-click the folder.
4. Choose Folder Properties.
5. Select the stock that you want to remove from the folder.
6. Click Remove.
7. Click OK.

{button ,AL(`H_SC_OVERVIEW_INTERNET_FOLDERS_OVER;H_SC_ADDING_STOCKS_STEPS',0)} See related 
topics



Dragging URL links to SmartCenter
You can add Uniform Resource Locator (URL) links to file folders. The URL link displays as a shortcut.
1. Click the drawer to open it.
2. Click the file folder to open it.
3.  In your Web browser, find the URL you want to create a shortcut for.

Note URLs appear as highlighted text in your browser.
4. Drag the URL to the opened file folder.

{button ,AL(`;H_SC_ADDING_INTERNET_FOLDERS_STEPS;H_SC_OVERVIEW_INTERNET_FOLDERS_OVER',0
)} See related topics



Overview: Internet folders
Internet folders let you get valuable information from the Web without leaving SmartCenter.
Note You must have Internet access to use Internet folders, and some of these folders may not be available in all 
markets.

Suite Help drawer
The Suite Help drawer contains two types of Internet folders: the Lotus Online folder and the SmartSuite Tips folder.

Lotus Online folder
The Lotus Online folder provides links to Lotus pages on the Web. Lotus on the Web offers:

• Updates to Lotus products
• New product announcements
• Product support, where you can

• Ask technical questions
• Download updates
• Browse frequently asked questions

SmartSuite Tips folder
The SmartSuite Tips folder provides valuable tips on using SmartSuite from the computer experts at PC World's 
TipWorld.    Tips are added Monday through Friday.

Addresses drawer
The Addresses drawer contains a Maps folder.    The Maps folder uses MapQuest's Interactive Atlas to generate 
maps of over 3 million cities and towns worldwide. You can also use it to generate driving directions to anywhere in 
the United States.

Internet drawer
The Internet drawer contains the following folders:

News folder
Whether it's national news, international news, or sports, the News folder lets you keep current on the day's events.

Stock Quotes folder
The Stock Quotes folder lets you monitor your favorite stocks in the financial markets. Maximize the folder to get 
detailed corporate news, earnings reports, company profiles, and other market services.

Weather folder
The Weather folder keeps you informed about changes in the weather.    You can select the regions and cities that 
you want to monitor. Maximize the folder to display satellite weather maps.

Web Reference folder
The Web Reference folder lets you search the Web.    The Web Reference also provides links to a variety of topics.

Travel Reservations folder
The Travel Reservations folder lets you research and book travel plans through Travelocity, a service of SABRE 
Interactive. 

Favorites folder
If you use Microsoft Internet Explorer, SmartCenter automatically includes a Favorites folder.    This folder provides 
easy access to your Favorites list of URLs (Uniform Resource Locator) that you have picked in Explorer.

Bookmarks folder
If you use Netscape, SmartCenter automatically includes a Bookmarks folder. This folder provides easy access to the
Bookmarks you have picked in Netscape.

And more
You can add Internet folders to SmartCenter that link you to sites on the Web that you specify. See Adding web sites 
to SmartCenter .
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Adding names to address folders
1. Click the Addresses drawer to open it.
2. Click the Addresses folder to open it.
3. Click Add Name.

An address card appears, opened to the last section that you used.
4. Enter information for the person, tabbing between fields.

Note In the street address box, you can press CTRL-Enter to start a new line, and press CTRL-Tab to insert a 
tab.

5. Click OK to save the information.
6. Click the front of the drawer to close it.

{button ,AL(`H_SC_CHANGING_NAME_AND_ADDRESS_BOOK_STEPS;H_SC_CHANGING_NAME_AND_ADDR
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Step 4: Options
Use Step 4 to specify a Word Pro SmartMaster template for writing letters and the way you want names to appear in 
an address folder.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

Display names
Select the order for the display of first and last names in the address folder.

Write a letter
Type the path and file name of the Word Pro SmartMaster template that you want to use to write a letter or click 
Browse to select a file.



Step 2: Basics
Use Step 2 to specify a    label, color, and icon for the folder that you are adding to a drawer.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

Folder type
Shows the type of file that you selected in Step 1.

Folder label
Enter the label that you want to display on the front of the folder.

Color
Select the folder color you want.

Icon
Select the icon you want to display on the front of the folder



Step 3: Calendar
Use Step 3 to specify the file that holds calendar data.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

File type
Select the type of file that you want the calendar folder to use as a source file. If you are not using an 
Organizer .OR2, .OR3 or .OR4 file, you will see only "text file" in the drop down list box.

Name of Lotus Organizer/text file
Type the name of the Organizer or text file that you want the calendar folder to use, or click Browse to select a file.
Organizer files must have an .OR2, .OR3, or .OR4 extension.

Section
An Organizer calendar can have multiple sections. For example, one section can contain your own calendar and 
another section can contain a calendar for someone else in your organization. Select the section that you want to use
in your SmartCenter calendar folder. A folder can only display one section at a time.

Appointment alerts
If you want the calendar drawer to alert you of an upcoming appointment, check the Open drawer box, and enter the 
number of minutes before your appointment you want to be alerted. The drawer will open to alert you.



Changing drawer properties
You can use the Drawer Properties dialog box to change labels and handles for drawers.

Choose a task
Changing drawer labels 
Changing handles on drawers 



Changing the source file of a    name and address book
You can use Organizer or a text file as the source file for your name and address book. 
1. Click the Addresses drawer to open it.
2. Click the Addresses folder.
3. Right-click the address tab.
4. Choose Folder Properties.
5. Click the Name & Address tab.
6. Select another source file in the File type box.
7. Type the path and file name of your source address book in the "Name of Lotus Organizer/text file" box.
8. (Optional) If you select Lotus Organizer as your file type, you can select an address book section in the Section 

box.
9. Click OK.

{button ,AL(`H_SC_CHANGING_NAME_AND_ADDRESS_INFORMATION_STEPS;H_SC_DIALING_TELEPHONE_
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Changing name and address information
1. Click the Addresses drawer to open it.
2. Click the Addresses folder.
3. Right-click the addresses tab.
4. Click the letter, and then the name of the person whose address you want.

Tip For more ways to look for addresses, click Selecting a name.
5. Click the edit button.

6. Tab to the field that you want to change.
Note In the street address box, you can press CTRL-Enter to start a new line, and press CTRL-Tab to insert a 
tab.

7. Click OK, and the click the  (close button) at the top right of the address card.
8. Click the front of the drawer to close it.
Note If you are using Organizer as your source address book, this procedure also updates Organizer name and 
address information.
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Checking off Reminders
After you finish a task described in a reminder, you can mark it completed.
1. Click the Reminders drawer to open it.
2. Click either the Home or Business folder to open it.
3. Select the reminder.
4. Click the box on the far left side of the reminder to check it.

The text in the reminder displays with a line through it.

{button ,AL(`H_SC_KEEPING_REMINDERS_ON_TOP_STEPS;H_SC_OVERVIEW_REMINDER_FOLDER_OVER;
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Creating screen movies
You can create your own screen movies, which record screen activity.
1. Click the SmartSuite drawer.
2. Click the Lotus Applications folder.
3. Double-click the ScreenCam icon.

4. Click one of the following buttons:

•  to record sound only

•  to record screen activity

•     to record both screen activity and sound
5. Click Record and then OK to begin recording.

6. When the stopwatch disappears, perform the actions you want to record.
7. Click Stop to stop recording.

8. Click Play to view the movie.

9. Choose File - Save
10. Specify a name and location for the movie, and click OK.
Note If you want to use the sound features of SmartCenter, you must have the hardware and software for sound 
installed.



Changing drawer textures
You can customize the appearance of drawer fronts by selecting a texture that displays on the front.
1. Click the SmartCenter Menu button.

2. Choose SmartCenter Properties.
3. Click the Appearance tab.
4. Select a texture from the box.
5. Click OK.
Tip Another way to change textures is to click the blank part of SmartCenter,    position the mouse over SmartCenter, 
and press F8.
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Deleting reminders
1. Click the Reminders drawer to open it.
2. Click either the Home or Business folder to open it.
3. Click a reminder to select it.
4. Press Delete.
5. Click Yes.
Note If a reminder is out of the folder and on your desktop, just click it, and press Delete.
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Dialing telephone numbers from SmartCenter
SmartCenter lets you dial telephone numbers from your computer by using your modem and telephone numbers 
stored in your address folder.
1. Click the Addresses drawer to open it.
2. Click the Addresses folder.
3. Click the letter, and then the name of the person whose address you want.

Tip For more ways to look for addresses, click Selecting a name.
4. Click the Call button to place your call.

A Call Status dialog box appears instructing you to pick up your receiver.
5. Click Talk and pick up the receiver.
6. When you complete your call, click Hang-up.
7. Click the front of the Addresses drawer to close it.

{button ,AL(`H_SC_OVERVIEW_ADDRESS_FOLDER_OVER',0)} See related topics



Displaying name and address information
You can display the address and other information, such as telephone number, about the people listed in an address 
folder.
1. Click the Addresses drawer to open it.
2. Click the Addresses folder.
3. Click the letter, and then the name of the person whose address you want.

Tip For more ways to look for addresses, click Selecting a name.

{button ,AL(`H_SC_CHANGING_NAME_AND_ADDRESS_INFORMATION_STEPS;H_SC_CHANGING_NAME_AND
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Faxing from SmartCenter
SmartCenter lets you dial fax numbers from your computer by using your modem and fax numbers stored in your 
address folder.
1. Click the Addresses drawer to open it.
2. Click the Addresses folder.
3. Click the letter, and then the name of the person whose address you want.

Tip For more ways to look for addresses, click Selecting a name.
4. Click the Fax button.

{bmcfax.bmp}
A Call Status dialog box appears instructing you to pick up your receiver.

5. Click Talk and initiate your fax.
6. When you complete your fax, click Hang-up.
7. Click the front of the Addresses drawer to close it.

{button ,AL(`H_SC_OVERVIEW_ADDRESS_FOLDER_OVER;H_SC_DIALING_TELEPHONE_NUMBERS_STEPS',
0)} See related topics



Step 1: Type
Complete Step 1 to specify the folder type that you want to create. Select a folder type from the list.
Note It is important to complete the steps in sequence. When you complete a step, click Next. When you complete 
the last step, click Done.

Address folders
You can maintain name and address information in address folders. You can use an address folder to list and update 
address information in Organizer, or you can use it as a stand-alone address folder that is not connected to an 
Organizer address book.

Calendar folders
You can schedule and update your appointments in calendar folders. You can use a calendar folder to make simple 
changes to your calendar in Organizer, or you can use it as a stand-alone calendar.

Dictionary folders
You can search for definitions of English words in dictionary folders.

File folders
File folders work just like folders work on your Windows desktop. You can organize your work into file folders that can 
contain:

• Files
• Applications
• Notes databases
• Shortcuts
• Other folders

Internet Maps folders
You can use MapQuest's Interactive Atlas to generate maps of street address locations anywhere in the United 
States, or generate maps for cities, regions, and countries around the world.    Internet Map folders can also help you 
get to your destination by providing driving directions and highlighted route maps for North American destinations.

Internet weather, news, stock, or page folders
You can check out the weather, news, or latest stock quotes on the World Wide Web, or add your favorite Web sites 
using Internet folders.

Reminder folders
You can create reminders to keep track of your daily tasks.    You can drag them to your desktop or check them off or 
delete them as you complete tasks.

Travel Reservations folders
You can look up airfares and make flight reservations through Travelocity, a SABRE online travel service.

Thesaurus folders
You can search for English word synonyms in thesaurus folders.

SmartSuite Tips folders
You can learn more about SmartSuite by reading the valuable and timely tips that appear in the SmartSuite Tips 
folder. Each day, a TipWorld expert provides a new tip on using SmartSuite. TipWorld is a member of the PC World 
Online Network.



Overview: Installing additional language versions of applications
SmartSuite lets you access your Lotus applications in multiple languages. The first language you install becomes 
your default language. To add a second or third language version of a SmartSuite application, you must run the Install
again. SmartSuite Install informs you that you already have an existing copy of the product in a different language 
and preserves the directory structure of the default language. SmartSuite Install adds icons for the additional 
languages to the Start menu. These icons are identified by the two-character ISO language tag. For example, the 
icon for the French version of Freelance Graphics is labeled Freelance Graphics - FR.

Choosing another language version
If you installed additional language versions of SmartSuite applications, you can choose another language version by 
right-clicking:

• A SmartSuite application icon in the Lotus Applications folder in SmartCenter. 
• A SuiteStart icon. 

{button ,AL(`;H_SC_CHANGING_LANGUAGES_IN_SMARTCENTER_STEPS',0)} See related topics



Moving file folders to the Windows desktop
You can move file folders from drawers to the Windows desktop.
1. Click the drawer to open it.
2. Click the file folder that you want to move.
3. Click the folder icon.
4. Choose Move to Desktop.

{button ,AL(`H_SC_ADDING_NOTES_DATABASE_STEPS;H_SC_DELETING_FILES_STEPS;H_SC_FILE_FOLDE
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Step 3: Name & Address 
Use Step 3 to specify a name and address book.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

File type
Select the type of file that you want the address folder to use as a source file. If you are not using an Organizer .OR2,
.OR3, or .OR4 file, you will see only "text file" in the list box.

Name of Lotus Organizer/text file
Type the name of the Organizer or text file that you want the address folder to use, or click Browse to select a file.
Note Organizer files have an .OR2, .OR3, or .OR4 extension.

Section
An Organizer address book can have multiple sections. For example, you can have one section that contains your 
own address book and another section that contains an address book for someone else in your organization. Select 
the section that you want to use in your address folder. A folder can only display one section at a time.



Name and address information
Use the Name & Address tab to maintain information on names listed in address folders, as well as source address 
books.

Choose a task
Adding names to address folders 
Changing name and address information



Overview: Address folders
Address folders let you maintain name and address information. You can use your address folder as a stand-alone 
address book, or you can use it with the PIM version of Organizer to add, list, change, or delete names and 
addresses in Organizer.

Communicating from the address folder
If you have communication hardware and software installed on your system, you can initiate your favorite method of 
communication. Choose from the following methods:

Call 
Dials the person's telephone number.

Send mail 
Initiates sending mail to the selected person's business or home address. SmartCenter uses TeamMail. TeamMail 
works with your electronic mail system to allow you to send messages from within SmartCenter.

Write a letter 
Opens a Word Pro SmartMaster for composing a letter. Address data is automatically inserted in the SmartMaster.

Fax 
Dials a fax number.

Using the address folder and Organizer together
The information in your address folder is stored in a source file. There are two kinds of source files: text (.TXT 
extension) or Organizer (.OR2, OR3, or .OR4 extension). Organizer files are used for storing information in Lotus 
Organizer (the PIM-only version without group scheduling capabilities).
During installation, SmartCenter detects if you are already using Organizer. If your Organizer preferences are set to 
automatically open an .OR2, .OR3, or .OR4 file, then the Organizer file becomes your source file for the address 
folder. Every time you open the address folder, it refreshes with new information from Organizer.
If you are not using Organizer, or the address section of Organizer, SmartCenter install creates a .TXT file named 
ADDRESS.TXT for your source file. Later on, if you start to use Organizer, you can change your address folder 
source file    in SmartCenter.

Converting Organizer files
You can convert your files from previous releases of Organizer to .OR4 files.    While working in Organizer:
1. Choose Help - Help Topics and click the Index tab.
2. Type this phrase:

Converting files, from previous releases
3. Click the index entry you want, then click Display.

Address security
The first time you open an address folder after you start SmartCenter, it prompts you for your Organizer password if 
you have one. You will not be prompted for your password again, unless you choose Clear Passwords. If you clear 
your passwords, you must reenter your passwords the next time you want to use your address folder or any other 
password-protected folder.
You clear passwords by clicking the folder icon in an open folder and choosing Clear Passwords.
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Overview: Reminder folders
Reminder folders let you create and keep track of simple reminders.    You can edit, move, delete, or mark a reminder 
completed. You can drag a reminder from one reminder folder to another, or you can drag it out to your desktop 
where it acts like a sticky note stuck on your screen. You can even create a reminder by dragging text from an 
application to a reminder folder. 
The default installation of SmartCenter comes with two reminder folders in the Reminders drawer - the Home and 
Business folders. You can add more reminder folders to SmartCenter drawers.
Note A reminder can only be in a reminder folder or on the desktop.    If you try dragging a reminder to another type 
of folder, like a file folder, it may appear to be in the folder, but when you close the folder, the reminder is on the 
desktop.
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Reserving minimum space for SmartCenter
You can choose to have SmartCenter take up a minimum amount of space on the screen while you are working in 
other applications. This allows maximized windows to hide most of SmartCenter, giving you more space to work.
1. Click the SmartCenter Menu button.

2. Choose SmartCenter Properties.
3. Click "Reserve minimum space for SmartCenter".
4. Click OK.
Note Click the unhidden part of SmartCenter to maximize it.

{button ,AL(`;H_SC_DRAWERS_PLACE_ON_SCREEN_STEPS;H_SC_MOVING_DRAWERS_STEPS;H_SC_OVER
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Sending mail from address folders
You can use addresses from the address folder to send electronic mail.
1. Click the Addresses drawer to open it.
2. Click the Addresses folder to open it.
3. Click the letter, and then the name of the person whose address you want.

Tip For more ways to look for addresses, click Selecting a name.
4. Click the Send mail button.

The Mail dialog box appears with the mail recipient's e-mail address already inserted.
5. Type the message subject and the message that you want to send.
6. Click Send.

{button ,AL(`H_SC_OVERVIEW_ADDRESS_FOLDER_OVER',0)} See related topics



Setting up SmartCenter properties
Use the SmartCenter Properties dialog box to set preferences for SmartCenter.

Choose a task
Moving SmartCenter 
Displaying pop-up help on drawers 
Assigning sounds to drawer events 
Changing the opening speed of drawers 
Defining textures for drawers
Reserving minimum space for SmartCenter
Changing languages in SmartCenter 
Switching browsers 



Starting Organizer from an address folder
1. Click the Addresses drawer to open it.
2. Click the Addresses folder to open it.
3. Right-click the folder label.
4. Choose Open in Organizer.

Organizer starts and displays the Organizer address book. 
Note The Open in Organizer menu choice only appears if you have selected an Organizer file as the source file    for 
your address book.

{button ,AL(`;H_SC_OVERVIEW_ADDRESS_FOLDER_OVER',0)} See related topics



What's new in SmartSuite
SmartSuite has new features that help you to leverage the Internet and to work smarter and more effectively with 
your team.

Work the Web
SmartSuite uses the Internet to help make your business work more efficiently.

• Create Web sites quickly with FastSite. FastSite is the new Lotus application for posting 1-2-3, Word Pro, 
Approach, and Freelance Graphics files, or collections of files to the Web with just a few clicks of the mouse. 
FastSite also supports several Microsoft file formats.

• Use SmartSuite applications to publish files to HTML or high-fidelity jDoc.
• Bring data from any Web page with a table into a Web table on a 1-2-3 sheet. Once you create a Web table, 1-2-3

maintains the connection to the source. You can tell 1-2-3 when and how often to refresh the data from the Web, 
and change the table's name, Web address, display settings, and size.

• Quickly access great information on the Web, straight from    SmartCenter.
• In any SmartSuite application, add hyperlinks to text or objects, underline or change the color of hyperlink text, 

and more. 
• Share files with team members using Lotus eSuite, the new set of Java-based applications.

Share your work
SmartSuite lets you easily share documents with team members who use Microsoft Office 97, Corel WordPerfect 
Suite, as well as previous releases of SmartSuite. SmartSuite also gives you more assistance in migrating from 
previous versions of SmartSuite.

• New, high-fidelity read and write capabilities let you work with Excel and Word files in SmartSuite, preserving 
formats, formulas, dates, and print settings.

• "Sticky" file formats makes sharing files with others a cinch. For example, you can open a Microsoft Office file in 
SmartSuite, work on it, and then SmartSuite intelligently saves it back to its original file format.

• The Menu Finder makes migrating to SmartSuite effortless. For example, you can enter an Excel command into 
the Menu Finder and it displays the 1-2-3 equivalent.

• The alternative menu option in Word Pro lets you switch from Word Pro menus to menus like those found in 
Word, WordPerfect, or Ami Pro.

• KeyView for Lotus lets your team members, who have not installed SmartSuite, view, copy, and print any 
SmartSuite file.

The SmartSuite advantage
SmartSuite successfully integrates the latest technology.

• SmartSuite is the only office suite that is uniquely designed to take advantage of Lotus Notes, and Domino.
• IBM ViaVoice lets you record speech and instantly translate it into typed text in Word Pro, or convert text to 

speech.
• All of the programs in SmartSuite are Year 2000-compliant.
• SmartSuite lets you embed ActiveX and Java bean components in your work.
• The enhanced Install lets you install SmartSuite with a single click of a button.

{button ,AL(`;H_SC_ACCESSING_THE_INTERNET_STEPS;H_SC_OVERVIEW_DRAWERS_OVER;H_SC_SMART
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Word Pro SmartMaster
You need to select a Word Pro SmartMaster template to use for your letter. SmartCenter automatically inserts name 
and address information from the address folder into the SmartMaster.
Enter the file name and path of the SmartMaster into the "Name of Word Pro SmartMaster" box. You can click 
Browse to locate the SmartMaster. SmartMaster templates have an .MWP extension, and their default location is in 
the SMASTERS folder.



Writing letters
You can write letters using Word Pro SmartMaster templates. Word Pro inserts the person's address into the 
SmartMaster.
1. Click the Addresses drawer to open it.
2. Click the Addresses folder.
3. Click the letter, and then the name of the person whose address you want.

Tip For more ways to look for addresses, click Selecting a name.
4. Click the Write a letter button to start your Word Pro SmartMaster for writing letters.

5. In the Word Pro SmartMaster dialog box, either enter the name of the SmartMaster you want to use or click 
Browse to select one. The dialog box saves the SmartMaster that you used the last time you wrote a letter.
Word Pro starts, automatically inserting the person's address into the letter.

6. You can now write your letter.

{button ,AL(`H_SC_OVERVIEW_ADDRESS_FOLDER_OVER;',0)} See related topics



1-2-3 and FastSite
Once you add a 1-2-3® file to a FastSite site, you still can make changes to the Web conversion format and to a 
subset of the Web conversion options you've already selected for the file in 1-2-3.
You can publish 1-2-3 files as HTML pages or as jDoc documents. If you publish a file as an HTML page, FastSite 
retains the formulas in the file, and the file can be read back into 1-2-3. If you publish a file as a jDoc document, 
FastSite uses the jDoc technology to create a compact, cross-platform, high-fidelity replica of a file that retains its 
original formatting.

Changing the conversion format
1. In the site hierarchy, which is the left pane of the FastSite desktop, right-click the 1-2-3 file.
2. Select Properties.
3. Under Conversion format, select "HTML pages," "jDoc document," or "File Defaults."
Note For more information on 1-2-3 file defaults, see the 1-2-3 Help.

Changing Web publishing options
1. In the site hierarchy, which is the left pane of the FastSite desktop, right-click the 1-2-3 file.
2. Select Properties.
3. Click 1-2-3 Publishing Options.
4. Under Conversion format, select one of the following options:

• "HTML pages" if you want to publish a selected range
• "jDoc" if you want to publish the whole workbook, a selected sheet, or a selected range
• "File defaults" if you want to keep the publishing options you set in 1-2-3

Tip If you want to publish an unnamed range, publish the range first in 1-2-3 and save the file. When you change 
Web publishing options in FastSite, choose "File defaults."
5. Click OK.

Supported file types
You can include the following types of 1-2-3 files in a FastSite site:

File type File extension
1-2-3 97 and later  .123
1-2-3 Release 4  .WK4
1-2-3 Release 3  .WK3
1-2-3 Release 1  .WK1

{button ,AL(`;H_SC_ODYSSEY_OVER;H_SC_WHAT_IS_ODYSSEY_OVER',0)} See related topics



Approach and FastSite
FastSite publishes Approach® files as jDoc documents using the jDoc technology to create a compact, cross-
platform, high-fidelity replica. 
When you include an Approach file in a FastSite site, FastSite provides Web publishing information about the file so 
you can change the file without leaving FastSite. You can select what views you want to publish to the Web, as well 
as what records--in the form of named finds and sorts--you want to publish to the Web.
Note FastSite lets you add shortcuts to a file.    

Selecting a different view
When you add an Approach file with more than one view to FastSite, FastSite assumes you want to publish the last 
view created. If that's not the case, follow these steps to make a different selection:
1. In the site hierarchy, which is the left pane of the FastSite desktop, right-click the Approach file.
2. Select Properties.
3. Click Approach Publishing Options.
4. Under Select an Approach view, select a view.
5. Click OK to close the Web Conversion Options dialog box.
6. Click OK.

Selecting a different set of records
When you add an Approach file to FastSite, FastSite assumes that you want to include all records in the file when you
publish to the Web. If that's not the case, follow these steps to make a different selection:
1. In the site hierarchy, which is the left pane of the FastSite desktop, right-click the Approach file.
2. Select Properties.
3. Click Approach Publishing Options.
4. Under Select which records to convert, select a Named Find or a Sort.
5. Click OK to close the Publishing Options dialog box.
6. Click OK.

Supported file types
FastSite supports Approach .APR files.

{button ,AL(`;H_SC_ODYSSEY_OVER;H_SC_WHAT_IS_ODYSSEY_OVER',0)} See related topics



Freelance Graphics and FastSite
Once you add a Freelance Graphics® file to a FastSite site, you still can change the Web conversion format and Web
style.
You can publish Freelance Graphics files as HTML pages or as jDoc documents. A jDoc document, which uses the 
jDoc technology, is a compact, cross-platform, high-fidelity replica of a file. 

Changing the conversion format
1. In the site hierarchy pane, which is the left pane of the FastSite desktop, right-click the Freelance Graphics file.
2. Select Properties.
3. Under Conversion format, select "HTML Pages" or "jDoc document."
4. Click OK.

Changing Web publishing options
1. In the site hierarchy pane, which is the left pane of the FastSite desktop, right-click the Freelance Graphics file.
2. Select Properties.
3. Click Freelance Publishing Options.
4. Select a style from the "Style name" box.
5. Click OK to record your new choice.
6. Click OK.

Supported file types
You can include the following types of Freelance Graphics files in a FastSite site:

File type File extension
Freelance Graphics 97 and later .PRZ
Freelance Graphics 96 .PRE
Freelance Graphics symbol .SYM
Freelance Graphics SmartMaster content .SMC
Freelance Graphics SmartMaster look .MAS

{button ,AL(`;H_SC_ODYSSEY_OVER;H_SC_WHAT_IS_ODYSSEY_OVER',0)} See related topics



Word Pro and FastSite
Once you add a Word Pro™ file to a FastSite site, you still can make changes to the Web conversion format and to a 
subset of the Web conversion options you've already selected for the file in Word Pro.
You can publish Word Pro files as HTML pages or as jDoc documents. A jDoc document, which uses the Net-It 
Software technology, is a compact, cross-platform, high-fidelity replica of a file.

Changing the conversion format
1. In the site hierarchy, which is the left pane of the FastSite desktop, right-click the Word Pro file.
2. Select Properties.
3. Under Conversion format, select "HTML pages" or "jDoc document."
4. Click OK.

Changing Web conversion options
1. In the site hierarchy pane, which is the left pane of the FastSite desktop, right-click the Word Pro file.
2. Select Properties.
3. Click Word Pro Publishing Options.
4. Under File, select the parts of the document you want to include: the header, the footer, and/or the table of 

contents.
5. Click OK to close the Web Conversion Options dialog box.
6. Click OK.

Supported file types
You can include the following types of Word Pro files in a FastSite site:

File type File extension
Word Pro 97 and higher .LWP
Ami Pro® .SAM

{button ,AL(`;H_SC_ODYSSEY_OVER;H_SC_WHAT_IS_ODYSSEY_OVER',0)} See related topics



FastSite and the other SmartSuite applications
FastSite, the newest member of SmartSuite, is designed for users who want to contribute information to a Web site. 
You can use FastSite even if you're not a Webmaster and you don't need to know HTML.
FastSite lets you do the following:

• Create and manage Web sites.
• Post existing SmartSuite documents to the Web without having to copy and reformat them.
• Use ready-made Web SmartMaster looks to give your site a cohesive and professional look.
• Seamlessly update your information once it's on the Web.

Once you create a Web site, you can post it to any Web server. For example, you can post the Web site to a Domino 
server where FastSite takes advantage of the Domino search technology. 

Using FastSite
To use FastSite, from the Start menu, choose Programs - Lotus SmartSuite - FastSite. Then on the Choose Task tab, 
click "Create a new site." FastSite guides you through the steps for creating a site.

FastSite and SmartSuite files
When you include SmartSuite files in a FastSite site, FastSite provides Web publishing information about each file--or
a subset of it, depending on the application--that you can change without leaving FastSite. To learn more about a 
specific file type and the publishing information FastSite provides, see any of the topics below:

1-2-3 and FastSite
Approach and FastSite
Freelance Graphics and FastSite
Word Pro and FastSite
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Attaching a file to a Lotus Notes document
When you attach a file to a Lotus Notes document, you can open or detach the file later. You can attach a file from 
any SmartSuite application to a Lotus Notes document.
1. Start Lotus Notes.

2. Create a new document or open an existing one.
Tip If you open an existing document, choose Actions - Edit Document to switch to edit mode.

3. Click where you want to attach the file.
4. From the File menu, choose Attach.

5. Locate and select the file to attach.
6. Click Create.
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Copying an Organizer address into 1-2-3
You can copy a name and address from Organizer to a 1-2-3 workbook.
1. Start Organizer.

2. Open the file that contains the address you want to copy.
3. Click the Address tab.
4. Select the address record you want to copy.
5. From the Edit menu, choose Copy Special.
6. Select "Full Address (Default)" from the Fields box.

Tip You can copy various combinations of information from the address record by selecting the appropriate item 
in the Fields box.

7. Click OK.
8. Start 1-2-3.

9. Open the workbook and display the sheet in which you want to place the address.

10. Click where you want the address to appear in the sheet.
11. From the Edit menu, choose Paste.
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Copying a 1-2-3 range to a Word Pro document
You can use drag and drop to copy a 1-2-3 range to a Word Pro document.
1. Start Word Pro.

2.  Open the document in which you want to place the 1-2-3 range.

3. Start 1-2-3.

4. Open the workbook and display the sheet that contains the range you want to copy.

5. Select the range and drag it to the Word Pro button in the Windows taskbar. 
Tip  Position the mouse pointer on the range's border. When the mouse pointer changes to a hand, hold down the
mouse button and drag the range. Continue holding down the mouse button.
Word Pro becomes active.

6. Drag the range to the location in the Word Pro document where you want the 1-2-3 range to appear.
7. Drop the 1-2-3 range in place by releasing the mouse button.

The range appears in a frame in the Word Pro document. 
Notes

• The range is an object on top of the sheet so it does not overwrite your data. 
• You can reposition the range by dragging it to a new location. 
• To resize the range, select the frame, choose Frame - Graphics Scaling, and change the dimensions in the Width 

and Height boxes. 
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Copying a graphic from Freelance Graphics into Word Pro
You can use Copy and Paste to copy a drawing, a diagram, or clip art from Freelance Graphics into Word Pro.

 Show me a QuickDemo 
1. Start Freelance Graphics and open the presentation that contains the graphic you want to copy.

2. Select the graphic.
3. From the Edit menu, choose Copy.

4. Start Word Pro and open the document in which you want to place the graphic.

5. Click where you want the graphic to appear.
6. From the Edit menu, choose Paste.

The graphic appears in a frame in the Word Pro document.
Notes

• The graphic is an object on top of the document so it does not overwrite your text. 
• You can reposition the graphic by dragging it to a new location. 
• To resize the graphic, select the frame, choose Frame - Graphics Scaling, and change the dimensions in the 

Width and Height boxes.
• You can also use drag and drop to copy a graphic from Freelance Graphics to Word Pro.

{button ,AL(`H_SC_COPYING_A_FREELANCE_GRAPHIC_TO_123_STEPS;H_SC_COPYING_A_FREELANCE_TA
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Copying a graphic from Freelance Graphics into 1-2-3
You can use drag and drop to copy a drawing, a diagram, or clip art from Freelance Graphics into 1-2-3.
1. Start 1-2-3

2. Open the workbook and display the sheet in which you want to place the graphic.

3. Click the cell where you want the upper-left corner of the graphic to appear.
4. Start Freelance Graphics.

5. Open the presentation that contains the graphic you want to copy.

6. Click the graphic.
7. Drag the graphic to the 1-2-3 button in the Windows taskbar.

Tip Continue holding down the mouse button.
1-2-3 becomes active.

8. Drag the graphic to the 1-2-3 sheet and drop it in place by releasing the mouse button.
The graphic appears in the 1-2-3 sheet.

Notes
• The graphic is an object on top of the sheet so it does not overwrite your data. 
• You can reposition the graphic by dragging it to a new location. 
• You can edit the graphic in Freelance Graphics by double-clicking it. When you are finished editing, choose Close

or Exit & Return to (file name) from the File menu to return to 1-2-3.
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Copying data from a Freelance Graphics table into 1-2-3
You can use drag and drop to copy data from a Freelance Graphics table into 1-2-3.
1. Start 1-2-3.

2. Open the workbook and display the sheet in which you want to place the data from the table.

3. Start Freelance Graphics.

4. Open the presentation that contains the table you want to copy.

5. Select the table so handles appear on all four sides.
6. Drag the table to the 1-2-3 button in the Windows taskbar.

Tip Position the mouse pointer on the table's border, hold down the mouse button, and drag the table. Continue 
holding down the mouse button.

1-2-3 becomes active.
7. Drag the table to the 1-2-3 sheet and drop the data in place by releasing the mouse button.

{button ,AL(`H_SC_COPYING_A_FREELANCE_GRAPHIC_TO_123_97_STEPS;;H_SC_COPYING_A_FREELANC
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Copying a Freelance Graphics table into Word Pro
You can use drag and drop to copy a Freelance Graphics table into Word Pro.
1. Start Word Pro.

2. Open the document in which you want to place the table.

3. Start Freelance Graphics.

4. Open the presentation that contains the table you want to copy.

5. Select the table so that handles appear on all four sides.
6. Drag the table to the Word Pro button in the Windows taskbar.

Tip  Position the mouse pointer on the table's border, hold down the mouse button, and drag the table. Continue 
holding down the mouse button.
Word Pro becomes active.

7. Drag the table to the location in the Word Pro document where you want the table to appear.
8. Drop the table in place by releasing the mouse button.

The table appears in a frame in the Word Pro document.
Notes

• The table is an object on top of the document so it does not overwrite your text. 
• You can reposition the table by dragging it to a new location.
• To resize the table, click any cell, choose Size Row/Column from the Table menu, and change the dimensions in 

the Height and Width boxes. 
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Copying data from a Word Pro table into 1-2-3
You can use drag and drop to copy data from a Word Pro table to 1-2-3.
1. Start 1-2-3.

2. Open the workbook and display the sheet in which you want to place the data from the Word Pro table.

3. Start Word Pro.

4. Open the document that contains the table with the data you want to copy.

5. Click anywhere in the table.
6. Choose Select from the Table menu, and then choose Entire Table Contents to select the entire table.
7. Drag the table to the 1-2-3 button in the Windows taskbar.

Tip Position the mouse pointer on the table's border. When the mouse pointer changes to a hand, hold down the 
mouse button and drag the table. Continue holding down the mouse button.
1-2-3 becomes active.

8. Drag the table to the location in the 1-2-3 sheet where you want the data to appear.
9. Drop the Word Pro data in place by releasing the mouse button.

{button ,AL(`H_SC_COPYING_A_123_RANGE_TO_WORD_PRO_97_STEPS;H_SC_EMBEDDING_123_DATA_INT
O_WORD_PRO_STEPS',0)} See related topics



Creating an Approach dynamic crosstab using data in a 1-2-3 workbook
You can use Approach to analyze 1-2-3 data by creating dynamic crosstabs without leaving 1-2-3.
1. Start 1-2-3.

2. Open the workbook and display the sheet that contains the database table you want to use to create the dynamic 
crosstab.

3. Select the database table, including the column headings.
Note The database table must have at least two rows and three columns.

4. Choose Database from the Create menu, and the choose Dynamic Crosstab.

5. Click OK in the Dynamic Crosstab dialog box.
6. Click where you want the dynamic crosstab to appear in the sheet.

1-2-3 starts the Crosstab Assistant.
7. Hold down CTRL and select the fields for the crosstab's rows, click Add, and then click Next.
8. Hold down CTRL and select the fields for the crosstab's columns, click Add, and then click Next.
9. Select a field to use for the summary from the "Fields" box, select the type of summary you want to perform from 

the "Calculate the" box, and click Add.
10. Repeat step 9 for each field you want to summarize.
11. Click Done.

The dynamic crosstab appears in the 1-2-3 sheet.
Notes

• The crosstab is an object on top of the sheet so it does not overwrite your data. You can reposition the crosstab 
by dragging it to a new location.

• You cannot modify data in the crosstab.
• If you change the data in your 1-2-3 database table, Approach updates the crosstab automatically when you 

activate it.
• If you add a row or column to the database table in 1-2-3, you must redefine the range containing the table.

{button ,AL(`H_SC_CREATING_AN_APPROACH_FORM_FROM_DATA_IN_A_1-2-
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Creating an Approach form using data in a 1-2-3 workbook
You can use Approach to create customizable forms that streamline data entry and ensure accuracy without leaving 
1-2-3. 
1. Start 1-2-3.

2. Open the workbook and display the sheet that contains the database table you want to use to create the form.
3. Select the database table, including the column headings.
4. Choose Database from the Create menu, and then choose Form.

5. Click OK in the Create Form dialog box.
6. Click where you want the form to appear in the sheet.

1-2-3 starts the Form Assistant.
7. Enter a title, select a layout and a style for your form, and then click Next.
8. Hold down CTRL and select the fields for the form, click Add, and then click Done.

The form appears in the 1-2-3 sheet.
Notes

• The form is an object on top of the sheet so it does not overwrite your data. You can reposition the form by 
dragging it to a new location.

• If you modify data in your Approach form, the changes appear in your 1-2-3 database table. You cannot modify 
protected cells or formulas, or change field definitions while working with data in the form.

• If you change the data in your 1-2-3 database table, Approach updates the form automatically when you activate 
it.

• If you add a row or column to the database table in 1-2-3, you must redefine the range containing the table.
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Creating an Approach report using data in a 1-2-3 workbook
You can use Approach to create sophisticated summary reports of your 1-2-3 data without leaving 1-2-3. 

 Show me a QuickDemo
1. Start 1-2-3. Open the workbook and display the sheet that contains the database table you want to use to create 

the report.
2. Select the database table, including the column headings.
3. Choose Database from the Create menu, and then choose Report.

4. Click OK in the Create Report dialog box.
5. Click where you want the report icon to appear in the sheet.

1-2-3 starts the Report Assistant.
6. Enter a title, select a layout and a style for your report, and then click Next.
7. Hold down CTRL and select the fields for the report, click Add, and then click Next.
8. If you want to group the data, hold down CTRL and select the fields by which to group the data, click Add, and 

then click Next.
Note If you do not want to perform calculations on the data, click Done and skip the next step.

9. For each field on which you want to perform a calculation, select the field, click Add, and specify the type of 
calculation you want to perform. 

10. Click Done.
Approach opens and displays the report. To return to 1-2-3, choose Close & Return to Lotus 1-2-3 or Exit & 
Return to 1-2-3 from the File menu. 

Notes
• To print the report, double-click the Approach icon in the 1-2-3 sheet to start Approach and then choose Print from

the File menu.
• If you modify data in your Approach report, the changes appear in your 1-2-3 database table. You cannot modify 

protected cells or formulas, or change field definitions while working with data in the report.
• If you change the data in your 1-2-3 database table, Approach updates the report automatically when you activate

it.
• If you add a row or column to the database table in 1-2-3, you must redefine the range containing the table.

{button ,AL(`H_SC_CREATING_AN_APPROACH_DYNAMIC_CROSSTAB_WITH_A_1-2-
3_RANGE_97_STEPS;H_SC_CREATING_AN_APPROACH_FORM_FROM_DATA_IN_A_1-2-
3_FILE_97_STEPS;H_SC_CREATING_APPROACH_MAILING_LABELS_IN_123_STEPS;H_SC_LINKING_1-2-
3_DATA_TO_AN_APPROACH_DATABASE_97_STEPS;H_SC_USING_123_DATA_TO_CREATE_AN_APPROA
CH_DATABASE_STEPS',0)} See related topics



Creating Approach mailing labels in 1-2-3
You can use Approach to create mailing labels without leaving 1-2-3.
1. Start 1-2-3.

2. Open the workbook and display the sheet that contains the addresses you want to use.

3. Select the database table, including the column headings.
4. Choose Create - Database - Mailing Labels.

5. Click OK in the Create Mailing Label dialog box.
6. Click where you want the mailing labels icon to appear in the sheet.

1-2-3 starts the Mailing Label Assistant.
7. Select the address layout that you want to use.
8. Select the field from the Fields box that you want to appear in the first box of the address label.
9. Click Add.
10. Repeat steps 8 and 9 for each of the remaining fields you want to appear on the label.
11. Select the type and size of label.
12. Click Done.

Approach opens and displays the mailing labels. To return to 1-2-3, choose Close & Return to Lotus 1-2-3 or Exit 
& Return to 1-2-3 from the File menu. 

Notes
• To print the mailing labels, double-click the Approach icon in the 1-2-3 sheet to start Approach and then choose 

File - Print.
• If you modify the data in Approach, the changes appear in your 1-2-3 database table. You cannot modify 

protected cells or formulas, or change field definitions while working with the data in Approach.
• If you change the data in your 1-2-3 database table, Approach updates the mailing labels automatically when you 

activate it.
• If you add a row or column to the database table in 1-2-3, you must redefine the range containing the table.

{button ,AL(`H_SC_USING_ADDRESSES_IN_APPROACH_FOR_A_WORD_PRO_MAIL_MERGE_97_STEPS;H_S
C_CREATING_AN_APPROACH_DYNAMIC_CROSSTAB_WITH_A_1-2-
3_RANGE_STEPS;H_SC_CREATING_AN_APPROACH_FORM_FROM_DATA_IN_A_1-2-
3_FILE_STEPS;H_SC_CREATING_AN_APPROACH_REPORT_FROM_DATA_IN_A_1-2-
3_FILE_STEPS;H_SC_LINKING_1-2-
3_DATA_TO_AN_APPROACH_DATABASE_97_STEPS;H_SC_USING_123_DATA_TO_CREATE_AN_APPROA
CH_DATABASE_STEPS',0)} See related topics



Copying a 1-2-3 chart to a Freelance Graphics presentation
You can use drag and drop to copy a chart from a 1-2-3 workbook to a Freelance Graphics presentation.
1. Start Freelance Graphics.

2. Open the presentation in which you want the chart to appear.

3. Click New Page.
4. Select 1 Chart as the page layout and click OK.
5. Start 1-2-3.

6. Open the workbook and display the sheet that contains the chart you want to copy.

7. Select the chart and drag it to the Freelance Graphics button in the Windows taskbar.
Tip Position the mouse pointer on the chart's border and hold down the mouse button. When the mouse pointer 
changes to a hand, drag the chart. Continue holding down the mouse button.
Freelance Graphics becomes active.

8. Drag the 1-2-3 chart to the "Click here to create chart" box in the Freelance Graphics presentation.
9. Drop the chart in place by releasing the mouse button.

{button ,AL(`H_SC_LINKING_A_123_CHART_TO_FREELANCE_GRAPHICS_STEPS;H_SC_LINKING_A_123_RAN
GE_TO_A_FREELANCE_CHART_STEPS;;H_SC_USING_A_123_RANGE_TO_CREATE_A_FREELANCE_TAB
LE_STEPS',0)} See related topics



Embedding 1-2-3 data into Word Pro
When you embed 1-2-3 data in Word Pro, the 1-2-3 workbook becomes part of the document. You can use 1-2-3 
from within Word Pro to edit the data.
1. Start 1-2-3.

2. Open the workbook that contains the data you want to embed.

3. Select the data.
4. Choose Edit - Copy.

5. Start Word Pro.

6. Open the document in which you want to embed the 1-2-3 data.

7. Place the insertion point where you want the embedded data to appear.
8. Choose Edit - Paste Special.

9. Select Paste in the Paste Special dialog box.
10. Select Lotus 1-2-3    Workbook Object from the "As" box and click OK.

The 1-2-3 data you selected appears in the Word Pro document. 
Notes

• The entire 1-2-3 workbook is embedded in the document, not just the selected data. The 1-2-3 workbook is an 
object on top of the document so it does not overwrite your text. 

• You can reposition the workbook by dragging it to a new location.
• To resize the workbook, select the frame, choose Graphics Scaling from the Frame menu, and change the 

dimensions in the Width and Height boxes.
• To edit the 1-2-3 data within Word Pro, double-click the data. When you are finished editing, click elsewhere in the

Word Pro document.

{button ,AL(`H_SC_COPYING_A_123_RANGE_TO_WORD_PRO_97_STEPS;H_SC_LINKING_A_123_RANGE_TO
_A_WORD_PRO_TABLE_STEPS;H_SC_USING_WORD_PRO_AS_A_NOTEBOOK_STEPS',0)} See related 
topics



Importing Organizer addresses into Approach
You can import addresses from Organizer into an existing Approach database.
Note Make sure you have similar fields in the Approach and Organizer files.
1. Start Organizer.

2. Open the file that contains the addresses you want to import into Approach.
3. From the File menu, choose Export.
4. Select Address from the "From section" box.
5. Select dBASE (*.DBF) from the "Files of type" box.
6. Enter a name in the "File name" box for the file you are exporting.
7. Click Mapping.
8. Click Clear all.
9. In the "Fields in Organizer section" box, select the field you want to be the first field in the exported file and then 

click Field 1 in the "Fields in export file" box. 
10. Repeat step 9 for each field you want to include in the file you are exporting.
11. Click OK to return to the Export dialog box.
12. Click Export. 

Organizer exports the address records.
13. Start Approach.

14. Open the Approach (.APR) file where you want to store the Organizer addresses.
15. From the File menu, choose Import Data.
16. Locate and select the name of the Organizer file you want to import, as entered in step 6.
17. Click Import. Approach displays the Import Setup dialog box.
18. Rearrange the data and field names by dragging them into place. Click the arrow column to include data in the 

import.
19. Select "Add imported data as new records" from the "Import options" box. 

Note You can also select options to update existing records in the Approach file.
20. Click OK.

{button ,AL(`;H_SC_IMPORTING_APPROACH_ADDRESSES_INTO_ORGANIZER_STEPS',0)} See related topics



Importing Approach addresses into Organizer
You can import addresses stored in an Approach database into the Address section of an Organizer file.
Note Make sure you have similar fields in the Approach and Organizer files.
1. Start Organizer.

2. Open the Organizer file where you want to store the Approach addresses.
3. From the File menu, choose Import.
4. Select Address from the "Into section" box.
5. Select dBASE (*.DBF) from the "Files of type" box.
6. Locate and select the Approach file to import.
7. Click Mapping.
8. Click Clear all.
9. Click the first field in the "Fields in import file" box and then click the corresponding Organizer field in the "Fields in

Organizer section" box. Repeat this process for each field in the file you want to import.
10. Click OK to return to the Import dialog box.
11. Click Import to import the address records into Organizer.

{button ,AL(`;H_SC_IMPORTING_AN_ORGANIZER_FILE_INTO_APPROACH_STEPS',0)} See related topics



Starting 1-2-3 from Organizer at a scheduled time
You can preset an alarm in Organizer to open a file in another SmartSuite application at a specified time. This feature 
is useful when you need to perform a specific task in 1-2-3 at a particular time.
1. Start Organizer.

2. Type an entry in your Calendar, To Do, Calls, Planner, or Anniversary section.
Tip For an entry in the To Do section, specify a date so the Alarm button becomes available.

3. Click Alarm.
4. Click Browse.
5. Select All Files(*.*) in the "Files of type" box.
6. Locate and select the .123 or .WK4 workbook you want to open when the alarm goes off, and then click Open.

Tip If you want to start 1-2-3 but not display a particular workbook, locate and select 123W.EXE, and then click 
Open.

7. Set the time at which you want the alarm to go off in the Time box.
8. Click OK to close the Alarm dialog box.
9. Click OK.
10. When the alarm goes off at the specified time, click OK to display the file you selected.

{button ,AL(`;H_SC_LAUNCHING_APPROACH_FROM_ORGANIZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_L
AUNCHING_FREELANCE_GRAPHICS_FROM_ORGANIZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_LAUN
CHING_WORD_PRO_FROM_ORGANIZER_AT_A_SCHEDULED_TIME_STEPS',0)} See related topics



Starting Approach from Organizer at a scheduled time
You can preset an alarm in Organizer to open a file in another SmartSuite application at a specified time. This feature 
is useful when you need to perform a specific task in Approach at a particular time.
1. Start Organizer.

2. Type an entry in your Calendar, To Do, Calls, Planner, or Anniversary section.
Tip For an entry in the To Do section, specify a date so the Alarm button becomes available.

3. Click Alarm.
4. Click Browse.
5. Select All Files(*.*) in the "Files of type" box.
6. Locate and select the .APR file you want to open when the alarm goes off, and then click Open.

Tip If you want to start Approach but not display a particular file, locate and select APPROACH.EXE, and then 
click Open.

7. Set the time at which you want the alarm to go off in the Time box.
8. Click OK to close the Alarm dialog box.
9. Click OK.
10. When the alarm goes off at the specified time, click OK to display the file you selected.

{button ,AL(`;H_SC_LAUNCHING_1-2-
3_FROM_ORGANIZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_LAUNCHING_FREELANCE_GRAPHICS_FR
OM_ORGANIZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_LAUNCHING_WORD_PRO_FROM_ORGANIZER
_AT_A_SCHEDULED_TIME_STEPS',0)} See related topics



Starting Freelance Graphics from Organizer at a scheduled time
You can preset an alarm in Organizer to open a file in another SmartSuite application at a specified time. This feature 
is useful when you need to perform a specific task in Freelance Graphics at a particular time.
1. Start Organizer.

2. Type an entry in your Calendar, To Do, Calls, Planner, or Anniversary section.
Tip For an entry in the To Do section, specify a date so the Alarm button becomes available.

3. Click Alarm.
4. Click Browse.
5. Select All Files(*.*) in the "Files of type" box.
6. Locate and select the .PRZ file you want to open when the alarm goes off, and then click Open.

Tip If you want to start Freelance Graphics but not display a particular file, locate and select F32MAIN.EXE, and 
then click Open.

7. Set the time at which you want the alarm to go off in the Time box.
8. Click OK to close the Alarm dialog box.
9. Click OK.
10. When the alarm goes off at the specified time, click OK to display the file you selected.

{button ,AL(`;H_SC_LAUNCHING_1-2-
3_FROM_ORGANIZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_LAUNCHING_APPROACH_FROM_ORGANI
ZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_LAUNCHING_WORD_PRO_FROM_ORGANIZER_AT_A_SCHE
DULED_TIME_STEPS',0)} See related topics



Starting Word Pro from Organizer at a scheduled time
You can preset an alarm in Organizer to open a file in another SmartSuite application at a specified time. This feature 
is useful when you need to perform a specific task in Word Pro at a particular time.
1. Start Organizer.

2. Type an entry in your Calendar, To Do, Calls, Planner, or Anniversary section.
Tip For an entry in the To Do section, specify a date so the Alarm button becomes available.

3. Click Alarm.
4. Click Browse.
5. Select All Files(*.*) in the "Files of type" box.
6. Locate and select the .LWP file you want to open when the alarm goes off, and then click Open.

Tip If you want to start Word Pro but not display a particular file, locate and select WORDPRO.EXE, and then 
click Open.

7. Set the time at which you want the alarm to go off in the Time box.
8. Click OK to close the Alarm dialog box.
9. Click OK.
10. When the alarm goes off at the specified time, click OK to display the file you selected.

{button ,AL(`;H_SC_LAUNCHING_1-2-
3_FROM_ORGANIZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_LAUNCHING_APPROACH_FROM_ORGANI
ZER_AT_A_SCHEDULED_TIME_STEPS;H_SC_LAUNCHING_FREELANCE_GRAPHICS_FROM_ORGANIZER
_AT_A_SCHEDULED_TIME_STEPS',0)} See related topics



Linking 1-2-3 data to an Approach database
You can open a named range of a 1-2-3 worksheet to view or edit the range in an Approach form. When you link 1-2-
3 data to an Approach database, any changes you make to the .APR file are automatically reflected in the 1-2-3 
workbook.
Note 1-2-3 must be running, and the worksheet containing the range must be open.
1. Start 1-2-3.

2. Open the workbook that contains the data you want to link to an Approach database.

Note The data must be a named range. If you add a row or column to the range in 1-2-3 after linking it to an 
Approach database, you must redefine the range.

3. Start Approach and click Cancel in the Welcome dialog box, if it appears.

4. From the File menu, choose Open.

5. Select 1-2-3 Ranges (*) from the "Files of type" box.
6. Double-click the folder with the name of the 1-2-3 workbook.
7. Select the named range you want to link and click Open.

The first record appears in Approach.
8. From the File menu, choose Save Approach File, enter a name for the Approach file, and then click Save.

The next time you open the Approach .APR file, 1-2-3 will automatically start and display the linked workbook.
Note If you modify data in your Approach form, these changes will appear in your 1-2-3 workbook. You cannot modify
protected cells or formulas, or change field definitions while working in the database.

{button ,AL(`H_SC_USING_123_DATA_TO_CREATE_AN_APPROACH_DATABASE_STEPS',0)} See related topics



Linking a 1-2-3 chart to Freelance Graphics
When you link a 1-2-3 chart to a Freelance Graphics presentation, the Freelance Graphics presentation automatically
reflects any changes you make to the 1-2-3 chart data.
Note You are actually linking the chart's data, not the chart itself. If you change the appearance of the chart in 1-2-3, 
Freelance Graphics does not reflect the change. For example, if you link a 1-2-3 pie chart to a Freelance Graphics 
presentation and then change the chart type in 1-2-3 to stacked bar, a pie chart still appears in Freelance Graphics.
1. Start 1-2-3.

2. Open the workbook and display the sheet that contains the chart.

3. Select the chart.
4. From the Edit menu, choose Copy.

5. Start Freelance Graphics.

6. Open a presentation and display the page where you want to paste the linked 1-2-3 chart.

7. From the Edit menu, choose Paste.

8. Click OK.

{button ,AL(`H_SC_LINKING_A_123_RANGE_TO_A_FREELANCE_CHART_STEPS;H_SC_DRAG_123_TO_FREE
LANCE_STEPS',0)} See related topics



Linking a 1-2-3 range to a Freelance Graphics chart
When you link a 1-2-3 range to a Freelance Graphics chart, the Freelance Graphics chart automatically reflects any 
changes you make to the 1-2-3 data.
1. Start Freelance Graphics.

2. Open a presentation.

3. Click New Page.
4. Select "1 Chart" as the page layout and click OK.
5. Click the box that says "Click here to create chart."
6. Choose a chart type and style, and then click OK.
7. Click Import Data.
8. Select either 1-2-3 Worksheet (123) or 1-2-3 Worksheet (WK?) from the "Files of type" box.
9. Locate and select the file that contains the data to which you want to link, and then click Open.
10. If necessary, select the sheet from the Worksheet box that contains the data you want to link.
11. Select the range that contains the data from the Range Names box or select the data in the sheet itself.
12. Click the button next to the Data box.

Note You can use the same procedure to select a range for the title, legend, or x-axis labels, except you click the 
Title, Legend, or X Axis Labels button instead.

13. Select "Keep file links."
14. Select either Series by rows or Series by columns, and then click OK to return to the Edit Data dialog box.
15. Click OK to view the chart in the Freelance Graphics presentation.

{button ,AL(`H_SC_LINKING_A_123_CHART_TO_FREELANCE_GRAPHICS_STEPS;H_SC_DRAG_123_TO_FRE
ELANCE_STEPS',0)} See related topics



Linking a 1-2-3 range to a Word Pro document
When you link a 1-2-3 range to a Word Pro document, the document automatically reflects any changes you make to 
the 1-2-3 data.

 Show me a QuickDemo
1. Start 1-2-3. Open the workbook and display the sheet that contains the range.

2. Select the range.
3. From the Edit menu, choose Copy.

4. Start Word Pro and open a document.

5. Click where you want the linked data to appear.
6. From the Edit menu, choose Paste Special.

7. Select "Paste link to source." 
8. Select Lotus 1-2-3    Workbook Object in the "As" box and click OK.

The 1-2-3 data appears in a frame in the Word Pro document. 
Notes

• The 1-2-3 range is an object on top of the document so it does not overwrite your text. 
• You can reposition the range by dragging it to a new location.
• To resize the range, select the frame, choose Frame - Graphics Scaling, and change the dimensions in the Width 

and Height boxes.

{button ,AL(`H_SC_COPYING_A_123_RANGE_TO_WORD_PRO_STEPS;H_SC_LINKING_A_123_RANGE_TO_A_
FREELANCE_CHART_STEPS;H_SC_EMBEDDING_123_DATA_INTO_WORD_PRO_STEPS;H_SC_USING_W
ORD_PRO_AS_A_NOTEBOOK_STEPS',0)} See related topics



Sending and routing mail from 1-2-3
You can compose mail messages in 1-2-3 and send them without switching to your mail application. You can also 
send a workbook or a picture of a range to other 1-2-3 users who have electronic mail. When you route mail, you can 
send it from one recipient to the next in the order you specify.
1. Start 1-2-3.

2. Open the workbook you want to send.

3. (Optional) Display the sheet that contains the range you want to send as a picture and select the range.
4. From the File menu, choose TeamMail.
5. Select an option in the Send box:

• "Workbook with message" to route or send a message with the workbook as an attachment.
• "Message only" and then "Paste in a picture of the selection" to send a message with a pasted picture of the 

selected range.
Tip To send a 1-2-3 range, not just a picture of it, choose File - TeamReview instead of File - TeamMail.

6. Click OK.
7. If prompted, enter your password and click OK. 
8. Enter the name of the first recipient and any individual message in the TeamMail dialog box.
9. Repeat step 7 for each additional recipient.

Tip If you want to route a workbook as an attachment, enter the names in the order in which you want the 
workbook sent.

10. If you are sending a workbook as an attachment to your message, select one of the following:
• "Route from one address to the next" converts your list of recipients to a numbered route list.
• "Send to all addresses at once" broadcasts the message with the workbook to all the recipients at the same 

time.
11. Enter a subject and message for all the recipients.

Note Click the Options tab to specify additional routing options.
12. Click Send.

{button ,AL(`H_SC_SENDING_MAIL_FROM_APPROACH_97_STEPS;H_SC_USING_WORD_PRO_TO_SEND_MA
IL_97_STEPS;H_SC_USING_FREELANCE_TO_SEND_MAIL_97_STEPS;H_SC_ATTACHING_FILES_TO_NOT
ES_STEPS;H_SC_USING_ORGANIZER_TO_SEND_MAIL_97_STEPSH_SC_USING_CCMAIL_TO_SEND_MAI
L_STEPS',0)} See related topics



Sending and routing mail from Approach
You can compose mail messages in Approach and send them without switching to your mail application. You can also
send selected data or a database to other Approach users who have electronic mail. When you route mail, you can 
send it from one recipient to the next in the order you specify.
1. Start Approach.

2. Open the file you want to send.

3. (Optional) Select the records you want to send from the worksheet.
4. From the File menu, choose TeamMail, and then choose Send New Message.
5. Select an option in the Send box: 

• "Snapshot of the current view" to send a picture of the current view as a Windows Metafile (.WMF).
• "Approach file with" and then either "Current view only" or "All of the views" to send the current view or all 

views as an attachment. 
6. Click Send.
7. If prompted, enter your password and click OK.
8. Enter the name of the first recipient and any individual message in the TeamMail dialog box.
9. Repeat step 8 for each additional recipient.

Tip If you want to route a database as an attachment, enter the names in the order in which you want the range 
sent.

10. If you are sending a database as an attachment, select one of the following:
• "Send to all addresses at once" broadcasts the message to all the recipients at the same time.
• "Route from one address to the next" converts your list of recipients to a numbered route list.

11. Enter a subject and message for all the recipients.
Note Click the Options tab to specify additional routing options.

12. Click Send.

{button ,AL(`H_SC_SENDING_A_123_RANGE_97_STEPS;H_SC_USING_WORD_PRO_TO_SEND_MAIL_97_STE
PS;H_SC_ATTACHING_FILES_TO_NOTES_STEPS;H_SC_USING_FREELANCE_TO_SEND_MAIL_97_STEPS
;H_SC_USING_ORGANIZER_TO_SEND_MAIL_97_STEPS;H_SC_USING_CCMAIL_TO_SEND_MAIL_STEPS',
0)} See related topics



Using 1-2-3 data to create an Approach database
You can use a 1-2-3 sheet or named range to create an Approach database. When you open a Lotus 1-2-3 file, 
Approach creates:

• An Approach file (.APR)
• A database file with a copy of the spreadsheet data

 Show me a QuickDemo 
1. Start Approach and click Cancel in the Welcome dialog box, if it appears.

2. From the File menu, choose Open.

3. Select Lotus 1-2-3 (*.123, *.WK*) from the "Files of type" box.
4. Locate and select the 1-2-3 workbook that contains the data you want to use to create the Approach database.
5. Click Open.
6. Select the sheet or named range you want to use and click OK.
7. Specify the name of the Approach database and click Create.

Approach creates a new database using the 1-2-3 column headings as the field names.
8. From the File menu, choose Save Approach File, enter a name for the Approach file, and then click Save.

{button ,AL(`;H_SC_LINKING_123_DATA_TO_AN_APPROACH_DATABASE_97_STEPS;H_WT_CREATING_DATA
BASES_FROM_SPREADSHEETS_DETAILS',0)} See related topics



Using an Approach address database for a mass mailing in Word Pro
You can merge names and addresses from Approach into a Word Pro document to create a mass mailing. Make sure
you create the Approach address records before you start Word Pro.

 Show me a QuickDemo
1. Start Word Pro and open the document you want to mail.

2. From the Text menu, choose Merge, and then choose Letter.

The Mail Merge Assistant appears.
3. Under Select Data File, click Use Existing.
4. Select dBase/ANSI (*.DBF) from the "Files of type" box to show only the database files (.DBF).
5. Locate and select the database file (.DBF) that contains the address records and click Open.
6. Click OK in the Import dialog box to use the entire Approach file as your data source.
7. Under Select Letter to Merge, click Use Current.
8. Select a field name from the list in the Merge bar above the document, position the insertion point in the 

document where you want the merge field to appear, and click Insert Field.
Note If you want any punctuation, spaces, or line breaks to appear between fields, you must add them to the 
document.

9. Repeat the previous step for each field you want to insert and then click Done.
10. Under Merge, View, and Print, click Merge.
11. Specify whether you want to view the results of the merge on-screen, send them directly to the printer, or print to 

a file.
Tip You can click the Set Conditions button to specify conditions that the names and addresses must satisfy to be
included in the merge.

12. Click OK to perform the merge.

{button ,AL(`H_SC_USING_AN_ORGANIZER_FILE_AS_A_WORD_PRO_MERGE_FILE_STEPS;H_SC_USING_A_
123_WORKSHEET_AS_A_WORD_PRO_MERGE_FILE_97_STEPS;',0)} See related topics



Copying an Organizer address into Word Pro
You can copy names and addresses from Organizer to a Word Pro document.
1. Start Organizer.

2. Open the file that contains the address you want to copy.

3. Click the Address tab.
4. Select the address record you want to copy.
5. From the Edit menu, choose Copy Special.
6. Select "Full Address (Default)" from the Fields box.

Tip You can copy various combinations of information from the address record by selecting the appropriate item 
in the Fields box.

7. Click OK.
8. Start Word Pro.

9. Open an existing document or create a new one.

10. Click where you want the address to appear.
11. From the Edit menu, choose Paste.

{button ,AL(`H_SC_USING_AN_ORGANIZER_FILE_AS_A_WORD_PRO_MERGE_FILE_STEPS;H_SC_COPYING
_AN_ORGANIZER_ADDRESS_INTO_123_STEPS',0)} See related topics



Using Organizer addresses for a mass mailing in Word Pro
You can merge names and addresses from Organizer into a Word Pro document to create a mass mailing. Make sure
you create and save the Organizer address records before you start Word Pro.
1. Start Word Pro.

2. Open the document you want to mail.

3. From the Text menu, choose Merge, and then choose Letter.
4. Click Use Existing in "1. Select Data File."
5. Select Lotus Organizer 4.x (*.or4) in the "Type of file" box.
6. Specify the path and name of the Organizer data file.
7. Click Open to display the Mail Merge Assistant dialog box.
8. Click Use Current in "2. Select Letter to Merge."

The Merge bar displays at the top of the document.
9. Select a field name from the list in the Merge bar above the document, position the insertion point in the 

document where you want the merge field to appear, and click Insert Field.
Note If you want any punctuation, spaces, or line breaks to appear between fields, you must add them to the 
document.

10. Repeat step 9 for each field you want to insert and then click Done.
11. Under "3. Merge, View, and Print," click Merge.
12. Specify whether you want to view the results of the merge on-screen, send them directly to the printer, or print to 

a file.
Tip You can click the Set Conditions button to specify conditions that the names and addresses must satisfy to be
included in the merge.

13. Click OK to perform the merge.

{button ,AL(`;H_SC_USING_A_123_WORKSHEET_AS_A_WORD_PRO_MERGE_FILE_97_STEPS;H_SC_USING_
ADDRESSES_IN_APPROACH_FOR_A_WORD_PRO_MAIL_MERGE_97_STEPS;H_SC_USING_AN_ADDRES
S_FROM_ORGANIZER_IN_WORD_PRO_STEPS',0)} See related topics



Using a 1-2-3 range to create a Freelance Graphics table
You can use a 1-2-3 range to create a table in a Freelance Graphics presentation.

 Show me a QuickDemo
1. Start 1-2-3. Open the workbook and display the sheet that contains the range you want to copy.

2. Select a range.
3. From the Edit menu, choose Copy.

4. Start Freelance Graphics and open the presentation in which you want to create the table.

5. Click New Page.
6. Select Table as the page layout and click OK.
7. Click the "Click here to create table" box.
8. Select a table style.
9. Specify the same number of rows and columns as the range contains.
10. Click OK.
11. Click the top left cell in the Freelance Graphics table so there is a frame around the table.
12. From the Edit menu, choose Paste.

Note You can also use drag and drop to create a Freelance Graphics table from a 1-2-3 range.

{button ,AL(`H_SC_LINKING_A_123_RANGE_TO_A_FREELANCE_CHART_STEPS;H_SC_COPYING_A_FREELA
NCE_TABLE_INTO_123_97_STEPS',0)} See related topics



Using 1-2-3 data for a mass mailing in Word Pro
You can merge names and addresses from a 1-2-3 database table into a Word Pro document to create a mass 
mailing. Make sure you create and save the 1-2-3 database table before you start Word Pro. The 1-2-3 file should not
be open when you perform the merge.
1. Start Word Pro.

2. Open the document you want to mail.

3. From the Text menu, choose Merge, and then choose Letter.

The Mail Merge Assistant appears.
4. Under Select Data File, click Use Existing.
5. Select Lotus 1-2-3 (*.123) or Lotus 1-2-3 (*.W*) from the "Files of type" box.
6. Locate and select the workbook that contains the database table you want to merge and click Open.
7. Specify whether you want to use the entire workbook, a particular sheet, or a named range for the merge and 

click OK.
8. Click OK in the Merge Data File Fields dialog box to use field names stored in the first record in the database 

table.
9. Under Select Letter to Merge, click Use Current.
10. Select a field name from the list in the Merge bar above the document, position the insertion point in the 

document where you want the merge field to appear, and click Insert Field.
Note If you want any punctuation, spaces, or line breaks to appear between fields, you must add them to the 
document.

11. Repeat step 10 for each field you want to insert and then click Done.
12. Under Merge, View, and Print, click Merge.
13. Specify whether you want to view the results of the merge on-screen, send them directly to the printer, or print to 

a file.
Tip You can click the Set Conditions button to specify conditions that the names and addresses must satisfy to be
included in the merge.

14. Click OK to perform the merge.

{button ,AL(`H_SC_USING_ADDRESSES_IN_APPROACH_FOR_A_WORD_PRO_MAIL_MERGE_97_STEPS;H_S
C_USING_AN_ORGANIZER_FILE_AS_A_WORD_PRO_MERGE_FILE_STEPS;H_SC_CREATING_APPROACH
_MAILING_LABELS_IN_123_STEPS',0)} See related topics



Sending and routing mail from Freelance Graphics
You can compose mail messages in Freelance Graphics and then send them without switching to your mail 
application. You can also send selected pages or an entire presentation to other Freelance Graphics users who have 
electronic mail. When you route mail, you can send it from one recipient to the next in the order you specify.
1. Start Freelance Graphics.

2. Open the presentation that contains the pages you want to send.

3. From the File menu, choose TeamMail.
4. Select an option in the Send box:

• Message only
• Specified pages, as an attachment
• Current presentation, as an attachment

5. Click OK.
6. (Optional) If you are sending only a message, enter the recipient's name, the subject, and a memo, and then send

the message.
7. If you are sending selected pages, select the ones you want to send in the Mail Selected Pages dialog box and 

click OK.
8. If prompted, enter your password and click OK.
9. Enter the name of the first recipient and any individual message in the TeamMail dialog box.
10. Repeat step 8 for each additional recipient.

Tip If you want to route a presentation as an attachment, enter the names in the order in which you want the 
presentation sent.

11. If you are sending a document as an attachment, select one of the following:
• "Send to all addresses at once" broadcasts the message to all the recipients at the same time.
• "Route from one address to the next" converts your list of recipients to a numbered route list.

12. Enter a subject and message for all the recipients.
Note Click the Options tab to specify additional routing options.

13. Click Send.

{button ,AL(`H_SC_SENDING_A_123_RANGE_97_STEPS;H_SC_SENDING_MAIL_FROM_APPROACH_97_STEP
S;H_SC_USING_WORD_PRO_TO_SEND_MAIL_STEPS;H_SC_ATTACHING_FILES_TO_NOTES_STEPS;H_S
C_USING_ORGANIZER_TO_SEND_MAIL_97_STEPS;H_SC_USING_CCMAIL_TO_SEND_MAIL_STEPS',0)} 
See related topics



Using Notes data in Approach
You can view data from a Notes database in an Approach form, view, or report.
1. Start Approach and click Cancel in the Welcome dialog box, if it appears. 

2. From the File menu, choose Open.

3. Select Lotus Notes -    Workspace (*),    Lotus Notes - Server (*), or    Lotus Notes - Local (*) from the "Files of 
type" box.

4. If you selected Lotus Notes - Server (*) in step 3, specify the server that stores the Notes database you want to 
use. 

5. Specify the Notes database that contains the data you want to use. 
6. Click Open. 
7. Select the name of the view or form you want to use. 

Approach uses this name as the name of the view or form (the .APR file) unless you specify another name when 
you save the file. 

8. Click OK.



Using Present It!
You can create a Freelance Graphics presentation from a Word Pro outline by using the Present It! script that comes 
with Word Pro. 
1. Start Word Pro.

2. Open the document that contains the outline you want to use to create the presentation.

Note Make sure you apply the Number List style to the text in your outline.
3. Select the entire outline.
4. Choose Script & Macros from the Edit menu, and then choose Run.
5. Select "Run script saved in another file." 
6. Click Browse.
7. Select "Script Source (*.lss)" in the "Files of type" box.
8. Double-click the Scripts folder, if necessary.
9. Select PRSIT.LSS and click Open.
10. Click OK in the Run Script dialog box.

Freelance Graphics starts and displays your outline as a presentation using the default SmartMaster.



Using a Word Pro document as a notebook
You can use divisions in a Word Pro document to store links to other files related to a single project, including files 
from other SmartSuite applications and from the Internet. For example, in a Word Pro business plan, you can use 
divisions to store a marketing plan, a 1-2-3 expense report, a Freelance graphics presentation, and an Approach 
product inventory database.
1. Start Word Pro and open the document in which you want to store links to the related files.

2. Division from the Create menu.

3. Click Create OLE Division.
4. Specify whether you want the new division to appear before or after the current one and then click OK.
5. Select "Object from a file."
6. Select "Link to file" so any changes made in the source application will automatically appear in the Word Pro 

document.
7. Click Browse.
8. Locate and select the existing file to insert as a division and click Open to return to the Create Object dialog box.
9. Click OK.

The file you selected appears in its source application.
10. To return to Word Pro, choose Close or Exit (application name) from the File menu.

The new divider tab appears in the Word Pro document. 
Notes

• To see the divider tabs in the Word Pro document, click the button that appears just above the vertical scrollbar 
arrow. 

• To display the linked file, click the divider tab.

{button ,AL(`;H_SC_COPYING_A_FREELANCE_TABLE_INTO_WORD_PRO_97_STEPS;H_SC_COPYING_A_FRE
ELANCE_GRAPHIC_INTO_WORD_PRO_STEPS;H_SC_EMBEDDING_123_DATA_INTO_WORD_PRO_STEPS;
H_SC_LINKING_A_123_RANGE_TO_A_WORD_PRO_TABLE_STEPS',0)} See related topics



Sending and routing mail from Word Pro
You can compose mail messages in Word Pro and then send them without switching to your mail application. You can
also send selected text or a document to other Word Pro users who have electronic mail. When you route mail, you 
can send it from one recipient to the next in the order you specify.
1. Start Word Pro.

2. Open the document you want to send.

3. (Optional) If you want to send only some of the text in the document, select the text you want to send.
4. From the File menu, choose TeamMail.
5. Under Send, select one of the following options:

• Message only
• Message with current selection's text as message body
• Current document, as an attachment

6. Click OK.
7. If prompted, enter your password and click OK.
8. Enter the name of the first recipient and any individual memo in the TeamMail dialog box.
9. Repeat step 8 for each additional recipient.

Tip If you want to route a document as an attachment, enter the names in the order in which you want it sent.
10. If you are sending a document as an attachment, select one of the following:

• "Send to all addresses at once" broadcasts the message to all the recipients at the same time.
• "Route from one address to the next" converts your list of recipients to a numbered route list.

11. Enter a subject and a memo to all the recipients.
Note Click the Options tab to specify additional routing options.

12. Click Send.

{button ,AL(`H_SC_SENDING_A_123_RANGE_97_STEPS;H_SC_SENDING_MAIL_FROM_APPROACH_97_STEP
S;H_SC_ATTACHING_FILES_TO_NOTES_STEPS;H_SC_USING_FREELANCE_TO_SEND_MAIL_97_STEPS;
H_SC_USING_ORGANIZER_TO_SEND_MAIL_97_STEPS;H_SC_USING_CCMAIL_TO_SEND_MAIL_STEPS',0
)} See related topics



Basics
Use the Basics tab to specify a new label, color, or icon for the folder.

Folder label
Enter the label that you want to display on the front of the folder.

Color
Select the folder color you want.

Icon
Select the icon you want to display on the front of the folder



Calendar
Use the Calendar tab to specify the file that holds calendar data.

File type
Select the type of file that you want the calendar folder to use as a source file. If you are not using an 
Organizer .OR2, .OR3, or .OR4 file, you will see only text file in the drop-down list box.

Name of Lotus Organize/text file
Type the name of the Organizer or text file that you want the calendar folder to use, or click Browse to select a file.
Organizer files must have an .OR2, OR3, or .OR4 extension.

Section
An Organizer calendar can have multiple sections. For example, one section can contain your own calendar and 
another section can contain a calendar for someone else in your organization. Select the section that you want to use
in your SmartCenter calendar folder. A folder can only display one section at a time.

Appointment alerts
If you want the calendar drawer to alert you of an upcoming appointment, check the Open drawer box, and enter the 
number of minutes before your appointment you want to be alerted. The drawer will open to alert you.



Switching browsers
SmartCenter uses its own browser for displaying Web pages. You can switch to your system default browser if you 
prefer.
1. Click the cabinet button.

2. Choose SmartCenter Properties.
3. Click the Browser tab.
4. Click "Use system default browser."
5. Click OK.

{button ,AL(`;H_SC_SMARTCENTER_BROWSER_OVER',0)} See related topics
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Monitoring company news and financial markets
When you maximize the stock folder, you can view market news and access online services provided by PC Quote. 
Markets include Dow Jones, NASDAQ, S&P 500, and others.
1. Click the Internet Drawer.
2. Click the Stock Quotes folder.
3. Click the Maximize button at the top right corner of the drawer to display the right panel of the folder.

4. In the right panel, select one of the PC Quote online services.
Note When you can click on the stock symbol in the left panel, detailed information on that company displays in the 
right panel.

{button ,AL(`;H_SC_OVERVIEW_INTERNET_FOLDERS_OVER;H_SC_ADDING_INTERNET_FOLDERS_STEPS;H
_SC_ADDING_STOCKS_STEPS;H_SC_DELETING_STOCKS_STEPS',0)} See related topics



Displaying satellite and radar images in weather folders
You can display satellite and radar images of the world or close-ups of specific regions.
1. Click the Internet drawer to open it.
2. Click the Weather folder.

Note If you haven't selected a location to display in the folder, see Changing locations in weather folders .

3. Click the Maximize button  at the top right corner of the drawer.
The folder expands to the width of your screen.    A satellite image of the world appears in the right panel. This is a
large image which may take a moment to appear.

4. (Option) Click in the image to get a get a close-up satellite image of a specific country or continent.
5. (Option) In the left panel next to the current day's temperature

• Click the top arrow for a radar image of that city
• Click the bottom arrow for a satellite image of that city

The image appears in the right panel. It may take a moment to appear.

{button ,AL(`;H_SC_CHANGING_LOCATIONS_IN_WEATHER_FOLDERS_STEPS;H_SC_OVERVIEW_INTERNET_
FOLDERS_OVER',0)} See related topics



Display
Use the Display tab to specify appearance properties for your folder.

Display files as
Select the size of the icons that appear in the folder.

Arrange by
Icons represent files. The icons can be arranged by file name, type, size,    or date.



Finding maps using maps folders
You only need a street address to generate interactive maps.
1. Click the Addresses drawer.
2. Click the Maps folder to open it.
3. Enter address information in the appropriate boxes. You can enter all or part of an address.
4. Click Search.

The browser takes a few moments to generate a map.
5. (Optional) Click a zoom level for the view of the map that you want.
6. (Optional) To center the map, click a directional indicator (NW, N, NE, E, and so on) in the border of the map.

{button ,AL(`H_SC_GETTING_DRIVING_DIRECTIONS_USING_MAPS_FOLDERS_STEPS;H_SC_MAPS_FOLDER
_OVER',0)} See related topics



Getting driving directions using maps folders
You can use the Maps folder to get point-to-point maps and written driving directions. 
1. Click the Addresses folder to open it.
2. Click the Maps folder to open it.

3. Click the Maximize button  in the top right corner of the drawer.
4. Click "Driving directions" in the right panel of the folder.
5. Under "Enter a Starting and Destination Point" select either "Use Address" if you know the starting address 
or one of the points of interest from the drop-down list box.

If you select:
• "Use Address," then enter a street address, city, and state. 
• One of the points of interest, then enter a city and state.

6. Repeat the previous step for your destination point.
7. (Optional) Select a route type or route mapping option.
8. Click "Calculate Directions."

Either maps and driving directions appear, or you get a list that lets you narrow your choice of points of interest. 
You might need to narrow your choice and recalculate several times before you get results.

{button ,AL(`H_SC_FINDING_MAPS_USING_MAPS_FOLDERS_STEPS;H_SC_MAPS_FOLDER_OVER',0)} See 
related topics



Getting information from the Web
You can easily find information on the Web without leaving SmartSuite.

1-2-3 Web tables
1-2-3 can pull data from tables on the Web into workbooks on your computer, so you can easily work with the data. 
Since 1-2-3 maintains the link to the table on the Web, you can update your worksheet whenever the data changes. 
You can also schedule 1-2-3 to automatically refresh the data in the workbook at an interval that you specify.

Surfing the Web with Approach
The Surf the Net database in Approach helps you stay organized by making it easy to store and retrieve links to the 
World Wide Web.
The Surf the Net database includes over 500 useful Internet sites, including comments on their contents. Surf the Net
is fully searchable, and you can add more sites. You can find sites by keyword, Uniform Resource Locator (URL), 
category, or by form.

SmartCenter and the Web
The Internet folders in SmartCenter connect you to valuable information on the Web. Since SmartCenter has its own 
browser, you don't have to exit SmartSuite and start a separate Web browser to get this information. Check out the 
stock market, read about current events, get your local weather forecast, book a flight, locate driving directions, or 
read tips on using SmartSuite.    You can even add folders to monitor your favorite Web sites.

Organizer and the Web
Organizer lets you include a link to a    URL address on the Web within an Organizer entry.    For example, you can 
link a scheduled sales appointment to your client's home page on the Web.



Getting tips on using SmartSuite
The SmartSuite Tips folder is updated Monday through Friday by the experts at PC World's TipWorld.
1. Click the Suite Help drawer to open it.
2. Click the SmartSuite Tips folder.
3. Click any of the tips listed in the folder, and the tip displays in the browser.
Note You need Internet access to use the SmartSuite Tips folder.

{button ,AL(`;H_SC_SUITE_INFO_DRAWER_OVER',0)} See related topics



Location
Specify where your file folder will be located. 

New Folder
Add a new file folder. You can add shortcuts, programs, or files to it. You can also add Notes databases .

Shortcut to an existing folder and location
Add a shortcut to an existing folder.    Enter the path where the existing folder is located on your computer. 



Overview: Maps folder
Located in the Addresses drawer, the Maps folder uses MapQuest to help you find maps of anyplace in the world.

Maps
The Maps folder provides interactive maps. You can:

• Find a specific address by entering street, city, and state information (for areas outside the United States, fill in 
only city and country information)

• Zoom up and down to select the appropriate map.
• Locate places that interest you like hotels, parks, ATMs

Driving directions
When you maximize the Maps folder, the right pane provides access to door-to-door and city-to-city driving directions 
for North American locations. When you enter origin and destination addresses, written directions accompanied by 
map views get generated.

{button ,AL(`;H_SC_FINDING_MAPS_USING_MAPS_FOLDERS_STEPS;H_SC_GETTING_DRIVING_DIRECTION
S_USING_MAPS_FOLDERS_STEPS',0)} See related topics



Maximizing folders
You can expand folders to their maximum size. 
1. Click the folder that you want to maximize.

2. Click the Maximize button  in the top right corner of the drawer.
Note Different folder types have different behaviors when they are maximized.    For example, a Calendar folder 
displays seven days, and an Internet URL folder expands to a full-screen, single pane.    Other types display two 
panes.
The following picture is an example of an Internet News folder that has been maximized. You can click a link in the 
left panel and the linked page displays in the right panel. Its easy to navigate and there's no browser that pops up 
over your folder hiding your list of links.

{button ,AL(`;H_SC_ADDING_NEW_FOLDERS_STEPS;H_SC_CHANGING_FOLDER_COLORS_STEPS;H_SC_C
HANGING_FOLDER_ICONS_STEPS;H_SC_CHANGING_FOLDER_LABELS_STEPS;H_SC_FOLDERS_OVER',
0)} See related topics



Name & Address 
Use the Name & Address tab to specify a name and address book.

File type
Select the type of file that you want the address folder to use as a source file. If you are not using an Organizer .OR2,
.OR3, or .OR4 file, you will see only "text file" in the list box.

Name of Lotus Organize/text file
Type the name of the Organizer or text file that you want the address folder to use, or click Browse to select a file.
Note Organizer files have an .OR2, .OR3, or .OR4 extension. 

Section
An Organizer address book can have multiple sections. For example, you can have one section that contains your 
own address book and another section that contains an address book for someone else in your organization. Select 
the section that you want to use in your address folder. A folder can only display one section at a time.



News
Use News to specify the type of news to display in the Internet News folder.

News Type
Select Top stories (US-oriented), World, Business, Technology, or Sports Web sites to appear in the folder.

Refresh every X minutes
Click the Refresh box and select how often you would like the information to be updated. Replace X with a number 
that you specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Building Web sites with FastSite
Lotus FastSite is the newest member of SmartSuite, and it's designed with the Internet and intranets in mind. Created
specifically for people that want to contribute information to a Web site, FastSite lets you focus your time on the 
content of your site rather than the mechanics of getting your site on the Web. 

Create a site
You no longer have to know HTML to create a great-looking Web site. Using existing SmartSuite or Microsoft Word 
documents, you can create a Web site that you can easily post to any Web server.

Create a professional look
FastSite comes with professionally designed, ready-made Web SmartMaster looks to give your site a cohesive and 
professional look. You can customize these looks for your organization's environment.

Publish a site
Publish a FastSite to any Web server in three easy steps:

• Convert to Web pages
• Preview the Web pages
• Post the pages to the Web server

Connect with Domino
Unique to FastSite is its seamless integration with the Lotus Domino Web server.    You can easily move collections of
SmartSuite documents to Domino, and then take advantage of Domino's search and replication capabilities. Plus, 
you don't need a Notes client to browse FastSite on a Domino--any Web browser can do it.

{button ,AL(`;H_SC_APPS_ODYSSEY_AND_123_STEPS;H_SC_APPS_ODYSSEY_AND_APPROACH_STEPS;H_
SC_APPS_ODYSSEY_AND_FREELANCE_GRAPHICS_STEPS;H_SC_APPS_ODYSSEY_AND_WORD_PRO_
STEPS;H_SC_WHAT_IS_ODYSSEY_OVER',0)} See related topics



Options
Use the Options tab to specify a Word Pro SmartMaster template for writing letters and the way you want names to 
appear in an address folder.

Display names
Select the order for the display of first and last names in the address folder.

Write a letter
Type the path and file name of the Word Pro SmartMaster template that you want to use to write a letter or click 
Browse to select a file.



Printing pages from Internet folders
You can print the Web page that displays in an Internet, Travel Reservations, or SmartSuite Tips folder.
1. In an open Internet folder, right-click the folder label.
2. Choose Print.
3. Select the printer, print range, and the number of copies that you want to print.
4. Click OK.

Tip You can print the page that appears in the right panel of a maximized folder by clicking the print icon 

{button ,AL(`H_SC_OVERVIEW_INTERNET_FOLDERS_OVER;H_SC_SAVING_PAGES_FROM_INTERNET_FOLD
ERS_STEPS',0)} See related topics



Publishing to the Web
SmartSuite makes publishing to the Web easy to do. You can publish documents, presentations, spreadsheets, and 
databases directly from individual SmartSuite applications, or from FastSite . 

• 1-2-3, Approach, Freelance Graphics, and Word Pro have publishing assistants that guide you as you convert 
your files to Web pages. All the assistants share the same intuitive design.

• Word Pro lets you export an entire .LWP file to HTML or only the current division. You can export headers, footers,
and footnotes. Word Pro supports Cascading Style Sheets (CSS), so maintaining text formatting is simpler.

• 1-2-3 lets you publish an entire workbook to the Web or select a specific page or range.    The 1-2-3 Web graphic 
capability allows you to display all the objects in a 1-2-3 workbook: web queries, datalink tables, charts, and so 
on.

• Freelance Graphics lets you convert presentations for high fidelity or for fast download time.

The open/save dialog box
SmartSuite lets you open and save files on the Web, so you can share files with your team members in the next office
or around the world. The Open and Save dialog boxes let you open and save a document, worksheet, or presentation
on HTTP, FTP, or Domino servers.    You can analyze and edit files and then put them back out on the Web.

Editing Web pages with Word Pro
You can use Word Pro as an HTML editor to create Web-ready documents.    Use the Internet SmartMaster templates
in Word Pro to add professional-looking tables, graphics, online forms, and wallpaper backgrounds to your Web 
pages.    Make your page personal, or give it a polished, corporate look.

HTML 3.2
You can use the SmartSuite HTML 3.2 enhancements to preserve formulas, formatting, and settings when you share 
files via the Internet.

Publishing high fidelity documents
jDoc, a java-based viewing technology, lets you publish heavily formatted files from SmartSuite applications to the 
Web without loss of formatting.    For example, your spreadsheet looks the same in    your browser as it does when 
you print it in 1-2-3. You can view jDoc documents in any Java-enabled browser, such as Microsoft Internet Explorer 
3.02 or higher, or Netscape Navigator 3.0 or higher.

Hyperlinking
The Hyperlinking dialog box lets you add hyperlinks to your SmartSuite applications. You can automatically create 
hyperlinks from URLs typed in a file or create a hyperlink on a selected object or text. Click Browse to find a URL on 
the Web, or on a FTP, Notes, or local server.

Internet Setup Assistant
When you connect to the Internet for the first time, the Internet Setup Assistant helps you to configure your Internet 
settings. It guides you through FTP and HTTP configuration, and helps you to select security options.



Reminder
Use the Reminder tab    to specify the file that holds reminder data.

Reminder data
Reminders must be stored in a text file.

Name of text file
Type the name of the reminder text file that you want the reminder folder to use, or click Browse to select a file.

Desktop reminders always on top
Click box to keep a reminder on top of your desktop.    This makes a reminder appear to be "stuck" on your monitor 
like a sticky note.



Saving pages from Internet folders
You can save Web pages that appear in Internet folders as files.
1. In an open Internet folder, right-click the folder label.
2. Choose Save.
3. Enter a name in the "File name" box.
4. Click Save.

SmartCenter saves the file with the .HTM extension.

Tip You can save the page that appears in the right panel of a maximized folder by clicking the save icon 

{button ,AL(`;H_SC_OVERVIEW_INTERNET_FOLDERS_OVER;H_SC_PRINTING_PAGES_FROM_INTERNET_FO
LDERS_STEPS',0)} See related topics



Overview: SmartCenter Browser
The SmartCenter Browser displays Web pages when you click links in Internet folders. It can display most Web 
pages, but some components, like frames for example, are not supported. You cannot enter URLs in the SmartCenter
Browser, although you can navigate by clicking links or toolbar icons. 

Toolbar icon Click to
Move backwards through 
pages you have visited during 
this session
Move forward through pages 
you have visited
Refresh a page so it is current 
(the globe in the corner of the 
browser rotates while the page
refreshes)
Stop a page from appearing in
a browser
Save a page locally or to the 
network
Print a page

Note If you prefer to use your system's default browser for displaying Web pages instead of the SmartCenter 
Browser, see Switching browsers .

{button ,AL(`;H_SC_CHANGING_BROWSERS_STEPS',0)} See related topics



Stocks
Use the Stocks tab to specify the stocks that you want to display in the Internet Stocks folder.

List of stocks to track
Stocks are listed alphabetically by stock symbols. You can add as many stocks as you want. Click Symbol Guide to 
find the symbols for the stocks that you want to track.

View
Select all fields or price and net change only.

Refresh every X minutes
Click the Refresh box and select how often you would like the information to be updated. Replace X with a number 
that you specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Options
Specify your Internet settings and how often you would like the folder to be refreshed.

Refresh every X minutes
Click the Refresh box and select how often you would like the information to be updated. Replace X with a number 
that you specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



URL
Use the URL tab    to provide the Uniform Resource Locator (URL) link to an Internet or Intranet page.

Internet location
Type the URL link to the Web site.

Refresh every X minutes
Click the Refresh box and select how often you would like the folder to be updated. Replace X with a number you 
specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Weather
Use the Weather tab to specify the location whose weather you want to learn about. 

Select a region and city
Select a region for which you want to gather weather information.    This selection determines the cities that appear in 
the city box.
After you have selected a region, select a city in that region.

Refresh every X minutes
Click the Refresh box and select how often you would like the weather information to be updated. Replace X with a 
number that you specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



What's new in SmartCenter
SmartCenter has the following new features:

• Maximize folders    You can maximize folders    to use your full screen. Maximized folders deliver additional 
information right to your fingertips using either a two panel view in Internet folders, or a single panel view in 
calendar folders.

• SmartSuite Tips*    You can read tips for getting the most out of SmartSuite using the SmartSuite Tips folder. The 
SmartSuite Tips folder is updated daily by the experts at PC World's TipWorld.com.

• Travel Reservations    You can book a flight, research accommodations -- plan your whole trip using the Travel 
Reservations folder.

• Maps    You can use the Maps folder to get interactive maps of locations throughout the United States. You can 
also view maps for cities, and countries around the world. You can even get detailed driving directions and 
highlighted route maps for any North American destination.
*May not be available in all markets.

{button ,AL(`H_SC_OVERVIEW_DRAWERS_OVER',0)} See related topics



Changing folder colors
1. Click to open the drawer.
2. Click to open the folder.
3. Right click the folder label.
4. Choose Folder Properties.
5. Select the new color for your folder from the Color box.
6. Click OK.
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Changing folder icons
You can change the icons that display on the left side of folder tabs.
1. Click the drawer to open it.
2. Click the folder to open it.
3. Click the folder icon.
4. Choose Folder Properties.
5. Select a new icon from the Icon box.
6. Click OK.
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Changing folder labels
1. Click the drawer to open it.
2. Click the folder to open it.
3. Click the folder icon.
4. Choose Folder Properties.
5. Click the Basics tab.
6. Click in the right side of the Folder label box, and press Backspace until the existing label has been deleted.
7. Type the new label in the Folder label box.
8. Click OK.
Note Labels cannot be blank, and you cannot have two folders with the same label in a drawer.
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Changing font size
You can change the font size of your SmartCenter menus, drawer labels or folder labels.
1. Right-click in the Windows desktop.
2. Choose Properties.
3. Click the Settings tab.
4. Select a size in the Font size box.
5. Click OK.
6. Click Yes to restart your computer.
Note This changes the font size for all of your applications.

{button ,AL(`;H_SC_SMARTCENTER_PROPERTIES_OVER',0)} See related topics



Changing languages in SmartCenter
If you have SmartCenter installed in multiple languages, you can change the language in which SmartCenter text 
appears.
1. Click the SmartCenter Menu button.

2. Choose SmartCenter Properties.
3. Click the Language tab.
4. Select a language for SmartCenter.
5. Click OK.

{button ,AL(`;H_SC_INSTALLING_ADDITIONAL_LANGUAGES_OVER',0)} See related topics



Deleting folders
1. Click to open the drawer that contains the folder.
2. Click the folder to open it.
3. Click the folder icon.
4. Choose Delete Folder.
5. Click Yes to delete the folder.
6. Click the front of the drawer to close it.
Note If the deleted folder contained a shortcut    to a file or another folder, the original item is still preserved on your 
desktop. If you delete an address or calendar folder, the source file is not deleted.

{button ,AL(`;H_SC_FOLDERS_OVER',0)} See related topics



Drag, defined
Press the left mouse button and hold it while moving the mouse.



Dragging text to reminder folders
You can create reminder notes by dragging text from Word Pro and 1-2-3. For example, you can drag text from a 
Word Pro document to the reminder folder to create a new reminder note.
1. Click the Reminders drawer to open it.
2. Click either the Home or Business folder to open it.
3. Start your SmartSuite application.
4. Resize the application window so that both the application and the opened folder appear on the desktop.
5. Select the text that you want to use to create a new reminder.
6. Drag the text to the reminder folder.
Tip You can copy and paste information from a Notes document to a reminder, too.

{button ,AL(`;H_SC_ADDING_REMINDERS_STEPS;H_SC_OVERVIEW_REMINDER_FOLDER_OVER',0)} See 
related topics



Overview: Dragging and dropping in SmartCenter
You can drag the following objects from the desktop or Windows Explorer and drop them into SmartCenter file 
folders: files, folders, and shortcuts. You drag and drop in different ways depending on where you want to put the 
object.

If you want to:

• Add an object to an existing SmartCenter folder, drop it inside the opened file folder.
• Create a new SmartCenter folder with your object inside it, then drop it in the back of the opened drawer.

• Create a new drawer containing a file folder with your object inside it, then drop the object over the 

SmartCenter.
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Overview: Drawers
SmartCenter drawers are containers for folders.    When you first start SmartCenter the following drawers are 
included: SmartSuite,    Internet (optional), Calendar, Addresses, Reminders, Reference, Suite Help, and Business 
Productivity.    If some of the drawers do not appear on your screen, click one of the SmartCenter arrows next to the 
last drawer on the screen to see the rest of the drawers.

You can move drawers around in SmartCenter or you can add your own drawers.    You can also move folders 
between drawers or add your own folders. 

Drawers are customizable
You can design drawers to work the way you work.    For example, you can create a drawer to help you coordinate all 
the work you have done on a project. The My Project drawer in the picture below contains the following folders:

• A Budget file folder with 1-2-3® worksheets that help you monitor the cost of your project.
• A Correspondence file folder with customer letters written in Word Pro and a customer database created with 

Approach.
• A Sales Shows file folder with the demos and presentations that you created with ScreenCam® and Freelance 

Graphics®.
• A Home Page Internet folder that links you to your organization's home page on the Web.
• A Calendar folder for scheduling project meetings that uses Organizer® as a source file.

Drawer menu
If you want to change drawer properties, like the label or the handle, or to add folders to drawers, click the Drawer 
Menu button.
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File folders, defined
Use SmartCenter file folders for organizing your work. SmartCenter file folders work just like folders on the Windows 
desktop. They can contain:

• Files
• Applications
• Notes databases
• Shortcuts
• Other folders



Overview: File folders
SmartCenter file folders work like folders work on your desktop. They can contain:

• Files
• Applications
• Notes databases
• Shortcuts
• Folders from the desktop or Windows Explorer

SmartCenter file folders are versatile. They can contain any combination of the objects in the above list.
When you first start SmartCenter, the folders you see in the SmartSuite drawer and the Business Productivity drawer 
are file folders.
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Overview: Folders
When you open SmartCenter drawers, you get folders designed to help you get your work done. SmartCenter 
provides a variety of types of folders -- some for working with information from the Internet, others for organizing your 
different kinds of work. You can also customize SmartCenter folders. For example, you can move folders between 
drawers or you can create folders to meet your specific needs. 

Status indicators 
When you open a folder that links to the Web, a parade of ducks scrolls across the top of the folder while the Web 
page is loading. If the folder is maximized while the Web page is loading, a globe spins in the top right corner.

Folder menu
If you want to make changes to a folder or its contents, you can right-click the folder tab to see the folder menu.

Folders for working the Web
SmartCenter provides the following types of Internet folders:

Internet Maps folders
You can use MapQuest's Interactive Atlas to generate maps of street address locations anywhere in the United 
States, or generate maps for cities, regions, and countries around the world.    Internet Map folders can also help you 
get to your destination by providing driving directions and highlighted route maps for North American destinations.

Internet Weather, News, Stock, or URL folders
You can check out the weather, news, or latest stock quotes on the World Wide Web, or add your favorite Web sites 
using Internet folders .

SmartSuite Tips folders
You can learn more about SmartSuite by reading the valuable and timely tips that appear in the SmartSuite Tips 
folder. Monday through Friday, a TipWorld expert from PC World provides a new tip on using SmartSuite.

Travel Reservations folders
You can look up the airfares and schedules and make flight reservations through Travelocity, a SABRE online travel 
service.

Web Reference
You can look up phone numbers, find clip art, get financial data, use an online library, or get general information.

Lotus Online
You can consult this site for the latest information on new products and upgrades from Lotus and IBM.

Folders for organizing your work
SmartCenter provides the following types of folders that help you to organize your work. These folders use the 
resources you have on your system.

Address folders
You can maintain name and address information on the people you communicate with in address folders . You can 
use address folders to list and update address information in Organizer, or you can use it as a stand-alone address 
folder that is not connected to an Organizer address book.

Calendar folders
You can schedule and update your appointments in calendar folders . You can use one to make simple changes to 
your calendar in Organizer, or you can use it as a stand-alone calendar.



File folders
File folders work just like folders work on your Windows desktop. You can organize your work into file folders that can 
contain:

• Files
• Applications
• Notes databases
• Shortcuts
• Other folders

The folders that come in the SmartSuite drawer and the Business Productivity drawer are file folders.

Dictionary and thesaurus folders
You can search for English word definitions in a dictionary folder and word synonyms in a thesaurus folder.

Reminder folders
You can create reminders to keep track of your daily tasks.    You can check them off or delete them as you complete 
tasks. You can also drag    them out of a folder to your desktop.

{button ,AL(`H_SC_ADDING_NEW_FOLDERS_STEPS;;H_SC_CHANGING_FOLDER_COLORS_STEPS;H_SC_C
HANGING_FOLDER_ICONS_STEPS;H_SC_CHANGING_FOLDER_LABELS_STEPS;H_SC_DRAG_AND_DRO
P_OVER;H_SC_MOVING_FOLDERS_BETWEEN_DRAWERS_STEPS',0)} See related topics



Turning off "reminders always on top"
When you drag reminders out of a folder, they display on top of your desktop, like notes stuck on your monitor. You 
can turn this off for all the reminders on your desktop.
1. Right-click a reminder that displays on top of your desktop.
2. Deselect "Desktop reminders always on top."

Note This right-menu selection does not appear if you right-click on a reminder that is in the Home or Business 
folder.
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Looking up words in the dictionary or thesaurus
1. Click the Reference drawer to open it.
2. Click the Dictionary folder for a definition or the Thesaurus folder for a synonym.
3. Enter the word in English, and press Enter.
Notes

• If you misspell the word you were looking for, the dictionary and thesaurus will find a close match.
• The dictionary file is not included in the default installation of SmartCenter. If you installed from CD, place your

CD in the drive and click Retry to look up a word; otherwise run the Install program, select Customize 
features, and select Dictionary.
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Moving folders from drawer to drawer
1. Click the drawer that contains the folder you want to move.
2. Click the folder to open it.
3. Position the mouse over the folder tab and drag it to the drawer where you want the folder to reside.
Note The drawer that you are moving the folder to can be opened or closed.
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Overview: Reference drawer
SmartCenter has a Reference drawer with an English language dictionary and a thesaurus. These tools are easy to 
use and can help you to choose the right word to express yourself effectively.
Even if you misspell a word that you are looking for, the dictionary and thesaurus will try to find a close match.

Dictionary
The dictionary folder contains word meanings, pronunciations, syllabication, and origins.
Note The dictionary file is not included in the default installation of SmartCenter. If you installed from CD, place your 
CD in the drive and click Retry to look up a word; otherwise run the Install program, select Customize features, and 
select Dictionary.

Thesaurus
The thesaurus folder contains word synonyms.
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Searching the Internet with Web Reference
You can search the World Wide Web from SmartCenter using the Web Reference folder.
1. Click the Internet drawer to open it.
2. Click the Web Reference folder.
3. Do one of the following:

• In the Search the Web box, type a topic that interests you, and click Go. Web Reference produces a list of 
matches.

• Click one of the blue, underlined links to a Web page that interests you.
4. Click the drawer to close it.
Note Web Reference is not available in all countries.
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Selecting a name
You can select a name in an address folder by clicking the folder, typing the person's last name, and then pressing 
Enter. You can move to other names by pressing the following keys:
 or ¬ Selects previous name
¯ or ® Selects next name
Page Up Selects previous letter tab
Page Down Selects next letter tab
Enter Displays the address card



Shortcuts, defined
Shortcuts are icons that let you jump to programs, documents, folders, and databases that you use frequently. 
Shortcut icons have  in the lower left corner.



Overview: Changing the appearance of SmartCenter
You can change the appearance and sound effects of SmartCenter and its drawers and folders by changing their 
properties. Properties are characteristics of an object. A SmartCenter property can be a color, a label, a special icon, 
or a sound you hear when an object moves.
You use properties dialog boxes to make these changes. 

To change SmartCenter properties
1. Click the SmartCenter Menu button.

2. Choose SmartCenter Properties.

To change drawer properties
1. Right-click the front of the drawer.
2. Choose Drawer Properties.

To change folder properties
1. Click the drawer containing the folder you want to change.
2. Click the folder to open it.
3. Click the folder icon.
4. Choose Folder Properties.    
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Source files, defined
The information in your calendar and address folders is stored in source files. There are two kinds of source files: text
or Organizer.    Text files have an extension of .TXT.    Organizer files are the files that you use for storing information 
in Lotus Organizer and, depending on the version you use, have an extension of .OR2, .OR3, or .OR4.
During installation, SmartCenter detects if you have Organizer installed.    If you do, then the Organizer file becomes 
your source file for the calendar and address folders. Whenever you update calendar and address information, your 
Organizer gets updated, too.    If you are not already using an Organizer file, SmartCenter creates a .TXT file for your 
source file.



Starting Organizer from a calendar folder
1. Click the Calendar drawer to open it.
2. Right-click the folder label.
3. Choose Open in Organizer.

Organizer starts and displays the Organizer calendar. 
Note The Open in Organizer menu choice only appears if you have selected an Organizer file as the source file for 
your calendar.

{button ,AL(`;H_SC_CALENDAR_FOLDER_OVER;H_SC_CHANGING_CALENDAR_SOURCE_STEPS',0)} See 
related topics



Step 3: News
Use Step 3 to specify the type of news to display in the Internet News folder.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

News Type
Select Top stories (US-oriented), World, Business, Technology, or Sports Web sites to appear in the folder.

Refresh every X minutes
Click the Refresh box and select how often you would like the news to be updated. Replace X with a number that you
specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Step 3: Stocks
Use Step 3 to specify the stocks that you want to display in the Internet Stocks folder.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

List of stocks to track
You can add as many stocks as you want. Enter symbols directly, or click Symbol Guide to find the symbols for the 
stocks that you want to track.

View
Select all fields or price and net change only.

Refresh every X minutes
Click the Refresh box and select how often you would like the stock quotes to be updated. Replace X with a number 
that you specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Step 3: URL
Use Step 3 to provide the Uniform Resource Locator (URL) link to an Internet or Intranet page.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

Internet location
Type the URL link to the Web site.

Refresh every X minutes
Click the Refresh box and select how often you would like the page to be updated. Replace X with a number that you 
specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Step 3: Weather
Use Step 3 to specify the location whose weather you want to learn about. 
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

Select a region and city
Select a region for which you want to gather weather information.    This selection determines the cities that appear in 
the city box.
After you have selected a region, select a city in that region.

Refresh every X minutes
Click the Refresh box and select how often you would like the weather information to be updated. Replace X with a 
number that you specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Step 4: Location
Use Step 4 to specify where your file folder will be located. 
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

New Folder
Add a new file folder. You can add shortcuts, programs, or files to it. You can also add Notes databases .

Shortcut to an existing folder and location
Add a shortcut to an existing folder.    Enter the path where the existing folder is located on your computer. 



Step 3: Reminder
Use Step 3 to specify the file that holds reminder data.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

Reminder data
Reminders must be stored in a text file.

Name of text file
Type the name of the reminder text file that you want the reminder folder to use, or click Browse to select a file.

Desktop reminders always on top
Click box to keep a reminder on top of your desktop.    This makes a reminder appear to be "stuck" on your monitor 
like a sticky note.



Overview: Team computing in SmartSuite
Team computing tools in SmartSuite let you communicate and collaborate with your coworkers.

TeamMail
TeamMail™ works with your electronic mail system to let you send and reroute mail messages from within a 
SmartSuite application. You can choose the File - TeamMail command to send a message without leaving your 
SmartSuite application.    You can send a message with part or all of a 1-2-3 workbook, Word Pro document, 
Approach database, or Freelance Graphic presentation attached. You can send and receive mail messages from 
within Organizer, too.

TeamReview
TeamReview™ in Word Pro and Freelance Graphics lets you send a document or presentation to members of your 
team to review. You can control the editing privileges for individuals or for teams.
TeamReview in 1-2-3 lets you send a range of workbook data to other 1-2-3 users. You can send a range to members
of a team, collect their input, and have it returned to you automatically via your e-mail system. You can send the 
range to all recipients at once, or route it from one person to the next, tracking its progress along the way.

TeamConsolidate
TeamConsolidate™ lets you consolidate multiple Word Pro documents and Freelance Graphics presentations into 
one document, so you can easily evaluate reviews made by members of your team. TeamConsolidate in 1-2-3 lets 
you use Lotus Notes to combine and distribute workbooks to your team.

TeamShow
TeamShow™ lets you present or view screen shows on connected computers.    While a presenter on one computer 
runs a show, TeamShow coordinates the display of pages on the presenter's and viewer's computers. Speaker notes 
display only on the presenter's computer.

TeamSecurity
TeamSecurity in Approach and Word Pro lets you use file-sharing controls to secure your data, while you share it with
members of your team across a network.

Open and Save to Lotus Notes
SmartSuite makes it easy to open a file from Notes, edit it, and save it back to Notes. While working in a SmartSuite 
application, just click Lotus Notes in the File - Open or File - Save dialog box.

For more information
While working in 1-2-3, Approach, Freelance Graphics, or Word Pro:
1. Choose Help - Contents and click the Index tab.
2. Enter the name of the team computing tool discussed above.
3. Double-click the entry you want. 



Turning off sounds
Actions, such as closing drawers, elicit sounds.    You can turn these sounds off.
1. Click the SmartCenter Menu button.

.
2. Choose SmartCenter Properties.
3. Click the Effects tab.
4. In "the Events" box, select the drawer or folder action whose sound you want to change.
5. Select None from the Sound box.
6. Click OK.
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Uninstalling SmartSuite
You can uninstall SmartSuite to remove it from your computer.
1. Choose Start - Settings - Control Panel from the Windows taskbar.
2. Double-click Add/Remove Programs.
3. Click the Install/Uninstall tab.
4. Select Lotus SmartSuite.
5. Select "Uninstall all of SmartSuite" or "Uninstall selected SmartSuite applications" and then select a product.
6. Click Add/Remove.
Note You can only use the Add/Remove Programs to remove applications that were designed for Windows 95.



Using QuickDemos
QuickDemos are short demonstrations of actual tasks that show how SmartSuite applications work together.
To start a QuickDemo, just click the QuickDemo icon whenever you see one in a Help topic.

A QuickDemo opens a sample file, then performs the steps you see in Help one at a time. At the end of the 
QuickDemo, the sample file closes and you are returned to your presentation at the point you left off, with the Help 
window open, so you can perform the steps yourself. Files that you have created are not affected by the QuickDemo.
You can see QuickDemos of the following tasks:

Copying a graphic from Freelance Graphics into Word Pro 
Using a 1-2-3 range to create a Freelance Graphics table 
Linking a 1-2-3 range to a Word Pro document 
Using an Approach address database for a mass mailing in Word Pro 
Using 1-2-3 data to create an Approach database 
Creating an Approach report from data in a 1-2-3 file 



Making travel reservations
You can use the Travel Reservations folder to make travel plans. The Travel Reservations folder contains Travelocity, 
a SABRE online travel service.
1. Click the Internet drawer.
2. Click the Travel Reservations folder to open it.
3. Click the appropriate icon in the folder to make your flight, car, or hotel reservations. 

When you click an icon or a link in the Travel Reservations folder, the linked page displays in your default 
browser.

{button ,AL(`;H_SC_TRAVELOCITY_OVER',0)} See related topics



SABRE, defined
The SABRE Group is a world leader in the electronic distribution of travel-related products and services and is a 
leading provider of information technology solutions for the travel and transportation industry. 



Step 3: Options
Use Step 3 to specify your Internet connection and how often you would like the folder to be refreshed.
Note It is important to complete the steps in sequence. When you complete the last step, click Done.

Refresh every X minutes
Click the Refresh box and select how often you would like the folder to be updated. Replace X with a number that you
specify.

Internet Settings
Enter proxy, http, and port information for your Internet connection in the Internet Settings dialog box. You don't need 
to do this for each folder, because the Internet Settings dialog box maintains the settings for all of the Internet folders 
in SmartCenter. For information and help configuring Internet settings, see your system administrator.
If Internet Explorer is installed on your system and you want to change your server and port settings, you cannot 
change them in SmartCenter. You must change the settings in Internet Explorer. The next time you start SmartCenter,
the settings will be automatically updated.



Overview: Travel Reservations folder
The Travel Reservations folder in SmartCenter lets you look up the lowest airfares and make flight reservations 
through Travelocity, a SABRE online reservation system.    Through the SmartCenter link to Travelocity, you can also 
book rental cars and hotel rooms, arrange for cruises, and more.

Finding your destination and getting there
The Travel Reservations folder contains a link to the MapQuest Map It! service. You can generate interactive maps of 
street address locations anywhere in the United States, or generate maps for cities, regions, and countries around 
the world.    Map It! can also help you get to your destination by providing driving directions and highlighted route 
maps for North American destinations.
Note Some of these features may not be available in every market.
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Turning off the splash screen
You can turn off the splash screen, so it doesn't appear every time you start SmartSuite.
1. Click Start, and then choose Settings - Taskbar.
2. Click the    "Start Menu Programs" tab.
3. Click Advanced.
4. Double-click the Programs folder.
5. Double-click the Startup folder.
6. Right-click SmartCenter, and choose Properties.
7. Click the Shortcut tab.
8. Add a space and "/Q" to the end of the command in the Target box.    For example:

C:\lotus\smartctr\smartctr.exe /LEN /Q
9. Click OK.




